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WARNING
WARNING: HIGH VOLTAGES ARE PRESENT BEHIND THE COVERS AND IN THE PAN ASSEMBLY.

Never remove the pan access cover assembly or rear cover assembly since there are no user serviceable parts
inside. The electrical and/or sensitive parts may only be serviced by an authorized Service Representative.

Important Safeguards :Read all instructions before attempting to operate this equipment.
� To reduce the risk of fire and/or electric shock, do not attempt to disassemble this machine.

� The machine is not intended for use in hazardous locations. Do not use in environments known to
contain flammable or explosive gases.

� To prevent overheating, do not cover vent openings or use the machine over a radiator or heat register.

� To reduce the risk of injury, refer all non-operator service functions to qualified service personnel.

� Access only those operator designated areas of machine for jam clearing. All other areas of machine
requiring disassembly or removal of covers should only be accessed by qualified service personnel.

� This machine cabinet serves to enclose hazardous parts. If the machine has been dropped or otherwise
had the cabinet stressed in any way, report it to your local service representative.

� In the performance of operator service procedures, be certain the machine is unplugged from the wall.

� Do not attempt to use this product in an unauthorized manner. To do so may expose you to mechanical
and / or electrical hazards.

� Do not expose power cord to sharp points or edges.

� To protect against shock, the power cord must only be plugged into a grounded receptacle. The ground
pin on the plug must never be removed.

� The power cord should be routed so it cannot be walked upon.

� Do not operate this machine with a damaged power cord or plug.

� Unplug or otherwise disable this machine before cleaning.

� Know how to turn off power in the work area, and to summon help in the event of an emergency.

� Do not remove safety covers for cleaning, adjustments or repairs. Call your service representative.

� Keep office supplies such as paper clips, staples, rubber bands, etc., away from machine.

� Keep loose clothing ties, jewelry, and long hair away from moving parts of this machine.

� Ink formulations for use in this machine are critical. Use only those specified.

� Notice: Changes or modifications to this unit not expressly approved by the party responsible for
compliance could void the user’s authority to operate the equipment.

� Treat every circuit as if it were live. Check first with a neon tester or a voltmeter.

Federal Communications Commission Compliance
"This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:

1). This device may not cause harmful interference, and
2). This device must accept any interference received, including interference that may cause

undesired operation.



NOTE: This equipment has been tested and found to comply with FCC Rules Part 15 subpart B Class B for a digital
device. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications. If this equipment does cause harmful interference to radio
or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures: Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio / TV technician for help.

Shielded cables must be used with this unit to ensure compliance with the Class B FCC limits.

Canadian DOC Compliance.
"This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du
Canada.

Caution
Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Dispose of used batteries according to the manufacturer’s instructions.

VORSICHT 

Explosionsgefahr bei unsachgemäßem Austausch der Batterie. 
Ersatz nur durch denselben oder einen vom 
Hersteller empfohlenen gleichwertigen Typ. 

Entsorgung gebrauchter Batterien nach 
Angaben des Herstellers. 

ADVARSEL 

Lithiumbatteri − Eksplosionsfare ved fejlagtig håndtering. 
Udskiftning må kun ske med batteri af samme fabrikat og type. 

Levér det brugte batteri tilbage tilleverandøren. 

Notice
The information in this document is subject to change without notice. Bryce Office Systems makes no warranty of
any kind with regard to the material contained herein. Bryce Office Systems will not be liable for incidental or
consequential damages in connection with the furnishing, performance or use of this material.
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  Introduction 

This manual is for the person who is new to the Bryce 13K 
Address Printer and needs a step by step instructions to setup 
and operate the printer.  

Who is this 
manual for? 

The appendix at the end of the manual has information for 
those who are familiar with the 13K printer and simply want a 
quick reference or want more specific technical information 
on the 13K printer. 

 
The first and second chapter introduces you to the components 
of the printer and what accessories came with your new 
printer. Chapter 3 runs you through the basics of how to install 
and remove the parts that came in the accessory box with the 
printer.  

Sections 1 - 3 

Once the printer has been assembled some adjustments are 
necessary to maximize the performance of the printer. When 
working with the address printer these chapters will give you 
step by step instructions on what you need to do. It is always a 
good idea to read through menu section before running the 
printer. This section explains the options that are available to 
run a mailing job. 

Sections 4 - 6 

The chapter on Troubleshooting contains a list of possible 
problems you may encounter with the printer and their 
solutions. Periodically follow the general maintenance steps to 
keep the printer clean and functioning properly. 

Sections 7 

The appendices include a quick reference table for the 13K 
menus, a listing of the PCL commands the printer recognizes, 
a hex chart to help work through a HEX dump, and references 
of setting up the most popular software to work with the 
printer. The final section has a list of supplies available for 
your printer.  

Appendices 
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 Unpacking 

Unpacking 
  • As you remove the boxes contents, check the pieces against the following list. 

CH
__ 1
__ 2
__ 3
__ 4
__ 5
__ 6

Revis
 

ECK LIST  
. PAPER CATCH ASSEMBLY __  7. . INK CARTRIDGE (BLACK) 
. LONG FENCE __  8. CLAMP KNOB & WASHERS (2X) 
. SHORT FENCE __  9. USERS MANUAL 
. WIRE FORM __  10. PRINTER DRIVER & INSTRUCTIONS 
.BIN EXTENSION __  11. END COVER 
 LINE CORD __  12. ADDRESS PRINTER 
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 Parts of the Printer 

THE PARTS OF THE PRINTER 
 
Input Bin 

 
 
 
 

Control Panel & 
Print Station 

 
 

Catch Tray 
 
 

End Cover 
 
 Media for printing 

is placed in the 

input bin. The input bin consists of the Wire Form assembly, Sliding 

Fence (not shown for ease of illustration) and Separator H-Blocks. 
Adjust these components to run a variety of media. 

Print Head
Holder Assembly

Control Panel
(LCD DisplaySeparator H-Block

Assembly
Wire Form
Assembly

Feed Ramp

Catch Tray AssemblyEnvelope Thickness Knob
 

 
 Input Bin Print Station Catch Tray 

 The print station processes the data, produces the barcode and prints 
out the page. The ability to change the print quality and speed is 
handled through the Control Panel and menu options. Use the printers 
Adjustment Lever to further enhance the quality of the print. 

 The printed media is placed in the Catch Tray Assembly. Media can 
stack of up to five (5) inches (12.7 cm) in the tray before it has to be 
emptied. 

 Install the End Cover which is packed in the accessory box, by 
inserting the latches into the catches. 
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  Assembly of Printer Components 

The following environmental considerations must be kept in 
mind when selecting a location for the Address Printer.  Doing 
otherwise may affect the operation and performance of the 
Address Printer. 

Choosing a 
Good 
Location for
the Printer 1. Place the printer close enough to the computer for the 

parallel or serial cable to reach.  

2. Place the printer on a flat, stable surface. 
Note: AB switches are not 
recommended for operation 
with this printer. 

3. Use a grounded, dedicated outlet for the printer only. 
Note: Do not use an adapter plug. 

4. Avoid locations near direct sunlight, excessive heat, 
high humidity, moisture, or dust. 

5. Keep the entire system away from large motors or 
other appliances that might disturb the power supply or 
create potential interference. 

Removing 
Protective 
Materials 

The printer is protected during shipping by a sheet of 
corrugated cardboard around the Print Head Holder Assembly, 
a cardboard support tube next to the Feed Carriage Assembly 
and a wooden wedge between the Floor Assembly and the 
Print Station Cover Assembly. 

1. Raise the Front Door to gain access to the interior. 

2. Remove the corrugated cardboard. Be careful not to 
grab or pull on the ribbon or encoder strip in the back 
of the Print Head Holder Assembly. 

3. Lift the lever on the carriage assembly and unlock 
carriage. 

4. Remove the corrugated cardboard tube.  

5. Pull the wooden wedge from between the Floor 
Assembly and the Print Station 
Cover Assembly. 
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  Assembly of Printer Components 

Installation of 
the Wire Frame 
Assembly 

 
1. Move the Feed Ramp to the center of the Wire Frame 

Assembly. 

 
Position the Feed Ramp to the center of the Wire Frame Assembly and fasten in place.  

2. Turn the Clamp Knob to secure in place. 

3. Raise the Wire Frame to a vertical position. 

 

 
 
Press the Wire Frame Assembly into the rubber Feed Rollers to slide it beneath the paper deflector. 
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  Assembly of Printer Components 

4. Insert wire Frame under deflector. Press wire Frame 
against rubber rollers to clear deflector plate. 

 

Rotate Wire Frame Assembly between the carrage and the indicator arrow.  

5. Verify the Wire Frame is locked into feed carriage 
grooves before clamp knob and washer is installed. 

 
6. Turn the Clamp Knob on the Feed Carriage Assembly 

to hold the Wire Frame Assembly in place. 

Installing the 
Sliding Fence Included in the Accessory Kit is a long and short Sliding 

Fence. The fences keep the media together in a stack. Use the 
short Sliding Fence for postcards and media up to the size of 
#10 envelopes. Use the Long Sliding Fence for all other sizes. 
 
 

1. Locate the two long slotted Fence Retainer tabs on the 
Feed Carriage Assembly. This is where the Sliding 
Fence attaches to the printer. 
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  Assembly of Printer Components 

 
2. Slide the rectangular shaped edge of the Sliding Fence 

between the two tabs.  

 
The drawing is shown without the Wire Frame Assembly for ease of illustration.
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  Assembly of Printer Components 

Connecting 
the Printer 

Connect the Address Printer to either the serial port or parallel 
port of the computer. Initialize the Address Printers 
communications port by sending data to either the parallel or 
serial port. To change from the serial port to the parallel port 
or vice versa the printer must be reinitialized or manually 
changed through the Setup Menu. Doing otherwise may affect 
the operation and performance of the Address Printer. 

To connect printer to the computer do the following steps. 
Note: AB switches are not 
recommended for operation 
with this printer. 

1. Align the male end of the parallel or serial cable 
connector. Push the cable connector in. 

2. Secure the cable in place. Use the two wire clips 
located Parallel connector to snap into the tabs on the 
connector. Use the thumb screws on the serial 
connector to screw into the hex jack screws on the 
Electrical Bracket. 

3. Align the other end of the cable to the connector on the 
computer and push into the port. 

4. Secure the cable in place. Use the thumb screws on the 
connector to screw into the hex jack screws on the 
computer. 
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  Assembly of Printer Components 

The power cord receptacle is located on the Pan Assembly 
along with the ON/OFF power switch. Connect the power 
cord to a grounded outlet. 

Connecting 
the Power 
Cord 1. Push the female end of the power cord into the power 

receptacle. 

2. Plug the other end into a grounded power outlet. 
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  Operating the Printer 

The power cord is plugged in, the printer is connected to the 
computer. Now you can turn the power on.  Power On 
 

· Press on the printers' ON/OFF power switch. 
The switch is located on the rear of the printer 
next to the line cord receptacle. Press on the 
symbol "I" (ON) position. The printer LCD 
menu will display the printer is initializing and 
will automatically go ON LINE. 

The Address Printer uses an Ink Jet Cartridge for printing.  
You must install the Ink Jet Cartridge before you use the 
machine. To install the cartridge do the following: 

 

 

· Verify the LCD display message on the top line of the 
display is either OFF LINE or ON LINE. 

· Open the front cover. 

· On the top Control Panel, depress Replace Print 
Cartridge button (plus button) and the carriage will 
travel to the center position and stop. DO NOT 
MOVE THE CARRIAGE BY HAND!! Damage may 
occur to the carriage. 
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  Operating the Printer 

CAUTION Installing 
an Ink Jet 
Cartridge 

The ink in the print cartridge may be harmful if 
swallowed. Keep new and used cartridges out of reach of 
children. Discard empty print cartridges in the proper 
manner. 
 

1. Remove Cartridge from the shipping container by 
peeling top cover off. Be careful not to touch the 
copper ribbon. 

 
 

2. Gently remove both pieces of tape covering the ink 
nozzles on the print cartridge. Be careful not to touch 
the copper nozzles. 
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  Operating the Printer 

3. Hold cartridge from the notched handle on top of the 
cartridge. Gently insert cartridge down at 
approximately a 45 degree angle into the cradle of the 
Print Head Holder Assembly. 

4. Hold the handle on top of the ink cartridge. Gently lift 
up on the handle until the cartridge snaps into place. 
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  Operating the Printer 

 Removing 
an Ink Jet 
Cartridge 

1. Grasp the handle on top. Press down on the cartridge 
handle until the cartridge “pops” loose and falls 
forward. 

 
2. Lift the print cartridge out of the cradle. 
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  Operating the Printer 

Recheck that all the necessary components of the printer are 
installed. Preparing 

the Media • Is the Wire Form Assembly installed? 
• Is the Sliding Fence installed? 
• Is the printer plugged into a power outlet? 
• Does the printer have an Ink Jet Cartridge installed? 
• Is the printer connected to the computer? 
 
Now that all the parts of the printer are installed the printer 
needs to be adjusted to work with the media. To avoid 
problems of misfeeding and jams the media must also be made 
ready for the printer.  
 
Use the following steps to make the media ready for printing: 

1. Take a manageable pile of media and while holding 
them (as shown below in reference A), "fan" all sides 
of the media to make sure that each piece of media is 
free from one another. 

Note: Maximum 
thickness is 1/4” for the 
13K. 

2. Square the pile against the table top, assuring a square 
pile on all sides. (Reference B) This will also allow 
media to settle toward the bottom of a stuffed envelope 
and will increase the feeding capabilities of the printer. 

 
Fan All Sides of Media  Square Media 
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  Operating the Printer 

The printer is designed to feed and print on a variety of media 
with various finishes and coatings. The sharpness of the print 
quality will vary with different media types, depending on 
how absorbent the media is, as well as other qualities. The 
best results can be achieved using white wove bonded stock. 
The printing quality will be less sharp on tyvek, recycled and 
glossy media. 

Media 
Types 

The types of media the printer is able to use is: 
 

• Envelopes: should be stacked to feed with the 
bottom edge first (non flap edge). 

• Booklets: should be stacked with the sealed edge 
leading or stacked with the sealed edge placed 
parallel to the rear wall of the Rear Support Plate 
Assembly. 

• Catalogs: should be stacked with the sealed edge 
leading or stacked with the sealed edge placed 
parallel to the rear wall of the Rear Support Plate 
Assembly. 

• Postcards: must be 3.5” (7.62 cm) x 5” (12.7 cm) 
or larger.  

• Self Mailers: may be folded in half or “C” or “Z”. 
The media must be tabbed and not exceed the 
maximum allowable thickness. 

• Paper: may consist of 16 to 80lb of uncoated to 
coated stock. The maximum width and height is 
specified in Appendix G. 

All folded material and catalogs must be tabbed as per postal 
regulations. 

The paper types that can be used are: 

• White wove 
• Bond Paper 
• Recycled Paper 
• Coated Paper 
• Card Stock 
• Brown Kraft 
• Manila 
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  Operating the Printer 

Setting the 
proper feed 
gap 

To start a print job the feed gap should be set for each type of 
media used in the printer. The feed gap is the spacing between 
the feed rollers and the separators. Set the feed gap with a 
piece media by following these procedures: 

1. Lift the Latch Assembly to unlock and raise up the H-
Block Assembly.  

The three H-Blocks are shown shaded.  

Bryce 13K

2. Unlock all three H Blocks on the Print Station 
Assembly. 

Hint: set a smaller gap 
between the separators and 
feed roller, by using  
standard copy paper when 
using post cards. 

 
Raise Latch assembly to raise the H-Blocks.  

3. Take a piece of the media and place between the Feed 
Rollers and the H-Block Assemblies.  
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  Operating the Printer 

4. Square the edge of the media against the registration 
wall of the Center Plate.  

Bryce 13K

 
Place Media under separators 

5. Push the Latch Assembly down and allow the H-Block 
Assemblies to drop on top of the media. Keep the H-
Block Assembles up that won’t contact the media. 

When just one of the separator fingers is in contact 
with the media use another piece beneath the other 
separator finger and the Feed Roller to set the feed 
gap. 

6. Press the Latch Assembly all the way down to secure 
H-Block Assemblies in this position.  

When the feed gap is not set correctly the printer will have 
feeding problems. When the gap is too wide double feeding 
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  Operating the Printer 

(feeding two or more pieces at a time) will occur. If the gap is 
to small the media will jam beneath the separators. If you 
followed the preceding steps and are experiencing feeding 
problem using post cards or stuffed media try the following: 

 
Post cards - set a smaller gap between the H-Block 
Assemblies and the Feed Rollers. Try using a sheet of copy 
paper to set the feed gap. 

Stuffed Media - set a larger gap between the separator blocks 
and the feed roller. Try adding two or three, number ten (# 10) 
envelopes, on top of the media before setting the separators. 

 
Perform the preceding steps for setting the feed gap using #10 
envelopes. Notice that only two of the H-Block Assemblies 
completely rest on the envelope. The third H-Block has one 
separator finger on the envelope and one on the feed roller.  

Setup with 
#10 
Envelopes 

1. Take Sliding Fence off and remove out of the way. 

2. Fit a second envelope between the other half of the H-
Block Assembly and the Feed Roller. 

3. Loosen the H Block Knob to let the H-Block Assembly 
fall freely onto the envelope. Verify envelopes are 
between all the Separators Fingers and the Feed 
Rollers. 

4. Lock in place by tightening the H Block Knob. 

5. The Input Bin can now be filled with #10 envelopes 
for printing. The stack of envelopes should be 
"shingled" or layered with the piece on top partially 
covering the piece below it like shingles on a roof. 
Load into the input bin with flap away from the feed 
roller and facing downward. Start with just a few 
envelopes to start the stack and get the angled contour 
of the bin area, then add several more pieces. Then add 
the remainder of the stack. 

The Wire Form assembly supports the media stacked in the 
input bin area and redistributes the weight of the media to 
assist in the feeding of the media. The Wire Form assembly 
has three basic adjustments.  

Wire Form 
Adjustments  
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  Operating the Printer 

• Wire Form Center Adjustment to eliminate 
skewing of the media and print. 

• Wire Form Height Adjustment to allow the printer 
to feed media of varying density. Example: Rigid 
media is set low, light weight media is set high. 

• Wire Frame Ramp Adjustment improves the 
feeding of media by distributing the weight of the 
media stack onto the feed roller. 

 
The Feed Carriage Assembly needs to be adjusted with the 
Wire Form Assembly. Wire Form 

Center 
Adjustment 1. Place a piece of the media in the bin area against the 

Center Plate Assembly.  

2. Unlock Feed Carriage assembly by pushing locking 

lever down 

 
Adjust Feed Carriage 

3. Slide Feed Carriage Assembly to the center of the 
media. 

4. Pull lever up to lock Feed Carriage Assembly in place.  
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  Operating the Printer 

The Wire Form Assembly helps the printer feed the media. 
Use the following suggestions as a guide for setting the height 
of the Wire Form Assembly. When the media is: 

Wire Form 
Height 
Adjustment  • Heavy media- set low 

• Light media - set high.  
• Rigid media - set low 
 
To adjust the Wire Form Assembly: 

1. Loosen the Carriage Knob on the Feed Carriage 
Assembly. 

2. Move the Wire Form Assembly accordingly. 

Fee
Adj

 

3. Tighten the Carriage Knob to secure the Wire Form 
Assembly in place. 

 

 
Lock Clamp Knob 

 
Revis
d Ramp 
ustment 

Unlock Clamp Knob
Adjust the Feed Ramp Assembly beneath the rear edge of the 
media by: 

 
Adjust Wire Form 

Assembly 

1. Loosen the Knob on the Feed Ramp Assembly.  

2. Lower Feed Ramp beneath the back edge of the media. 
Place ramp where the media is halfway up the angled 
front edge. 

3. Tighten Knob to lock Feed Ramp into position. 
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  Operating the Printer 

 
 
Recheck your setup and adjustments: Sliding 

Fence 
Adjustment 

 
• Is the feed gap set? 
• Is the Wire Form in the center of the media? 

• Is the Wire Form at a good height? 
• Is the Feed Ramp beneath the edge of the media? 
 

Bryce 13K

 
Sliding Fence Installation: Insert Sliding 

Fence between slide guides and feed carriage 

Position the Sliding Fence before stacking the bin 
area with media. The fence has to be close enough to 
the media to keep it from going in at an angle and 
loose enough for the media to drop down to the Feed 
Rollers. To properly position the fence: 

1. Place a handful of the prepared media in the 
input bin area. 

2. Square the stack against the wall of the Rear 
Support Plate Assembly and the H-Block 

Assemblies. 

3. Push the Sliding Fence in near the media. Leave a gap 
the thickness of one or two #10 envelopes. This size of 
gap places the fence close enough to prevent pieces 
from twisting and turning as they enter the printer, and 
the fence won’t be to close to the media to trap and 
restrain the pieces between the fence and the wall of 
the Rear Support Plate Assembly. This would hinder 
the media from being fed into the printer.  

4. To put the media into the bin, start with a few pieces to 
get the proper contour. The media stack should be 
"shingled" when loaded into the input bin with flap 
away from the feed roller and facing downward. Add 
several more pieces. Keep adding to the stack until the 
bin is full of media. 

13 ection 4 -  
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  Printer Tips 

1. Typically adjust the Exit Roller Sliders, (1/4 of an 
inch) from the left and right edges of the media. Verify 
the Exit Roller Sliders do not  contact any printed 
information on the media. If it does these will act as a 
brush with paint and smear the print. If this condition 
exists, adjust the Exit Roller Sliders toward the nearest 
clear zone (non printing area of the media). 

Adjust the 
Exit Roller 
Sliders 

Output 
Stack 
Height 

1. The paper catch assembly will stack up to five (5) 
inches of media before it is necessary to remove the 
stack from the paper catch assembly. If the paper catch 
is not emptied regularly then there is the potential for 
out of sequence stacking , particularly when the printer 
is printing toward the top of the media. 

Increase Print Clarity by adjusting the print head height 
adjustment knob. 

Exit Roller Sliders

Envelope 
Thickness 
Adjustment Knob 

1. Adjust the envelope thickness knob to the fully opened 
position: ¼ “ Maximum, (turn the envelope thickness 
knob clockwise) reference Figure below. 

2. While the printer is printing, close the Envelope 
Thickness Knob (turning counterclockwise) until the 

printed message smudges.  Then back off the 
adjustment for the desired print quality. 
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 Printer Menu System 

 

 

Control Panel and 
LCD Display 

 
KEYPAD 
DEFINITIONS  

 
The printer buttons on the control panel perform the following functions: 

 
 

 
 

 
 

 
 
 
 
 
 

 
 

 
 

 

On Line button Use this button to toggle the printer between  ON 
LINE or OFF LINE. 

Menu button:  Press this button to go into the menus or to exit from 
the menus. 

(Minus) button Press this button, while in a menu, to scroll the menu 
features from bottom to top. 

(Plus) button: Press this button, while in a menu, to scroll the menu 
features from top to bottom. 

Replace Print When the printer is OFF LINE or ON LINE, 
Cartridge button: press this button to make the print head holder travel to 

the center position of the print platen for easy access 
when removing or installing a print cartridge. Press 
again to return the print head holder. 

Test Env. button: When the printer is OFF LINE, press this button to 
print an internal test address message. 

Enter button:  Press this button, while in a menu, to select a menu 
feature.  

Eject Env. Press this button to eject the piece of media under the 
exit sliders. 
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  Printer Menu System 

HOW TO USE THE MENUS  
Conventions 
used in the 
Printer Menu 
System section. 

Bold is used for the Menu, On Line, Enter, + (Plus), - 
(Minus) buttons when they must be pressed to program or 
operate the printer.  

ALL CAPITAL LETTERS are used to highlight words that 
appear on the LCD display, and menu options: i.e. MAIN 
MENU, SETUP MENU. 

Italics are used to define the function of the printers menu 
option.   

Capitalized are used to denote the name of the menu option: 
i.e. Main Menu, Setup Menu. 

Accessing 
the Menus 

The printer has two menu directories to program the printer. 
These menus are displayed on the LCD panel located on top 
of the printer. The two menus available are the Main Menu 
and the Setup Menu. Some of the menu options contain 
several layers of sub-directories of menu options. To access 
the printers menus the LCD display must show OFF LINE. 
The following steps outline how to access the two menu 
directories. 

• Press the On Line button until the LCD display shows 
“OFF LINE”. Pressing the On Line button on the 
control panel will toggle the printer from ON LINE to 
OFF LINE and vice versa. 

• To access the Main Menu depress the Menu button. 
MAIN MENU will be shown on the LCD display. 

• To access the Setup Menu depress the Menu button 
for two (2) seconds, until SETUP MENU is shown on 
the LCD display. 

• Press the + (Plus) or - (Minus) button to scroll 
through the options available in the Main Menu or 
the Setup Menu. 
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  Printer Menu System 

• Press the Enter button to choose the displayed 
option from the Main Menu or Setup Menu 
options. 

• Press the Menu button several times to back out of the 
Main Menu or Setup Menu until the printer displays 
OFF LINE. 

• Press the On Line button; now the printer displays ON 
LINE and is ready for use. 
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  Printer Menu System 

MAIN MENU 
Using the 
Main Menu 

Use the Main Menu level to choose the print specifications 
and page layout for your media. Select the desired option 
when it appears on the second line of the LCD. Note: An 
Asterisk (*) displayed before the menu option is an indicator 
of the current menu option setting. Selecting another menu 
option will install the asterisk before the option. Upon receipt 
of the printer from the factory the asterisk is typically the 
default setting. 

These options are covered in the following pages. 

1. ADDRESS LAYOUT 

2. PRINT QUALITY 

3. FONT 

4. BARCODE 

5. ADDRESS RECOVERY 

6. CLEAR COUNTER 

7. JOB SETTINGS 

Use this option to change the page layout for your mail piece. 
Use the following steps to access the Address Layout sub-
menus. 

1. ADDRESS 
LAYOUT 

• Press the + or - buttons to scroll through the Main 
Menu options until the  1. ADDRESS LAYOUT 
option is displayed on the LCD panel. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the 1. 
ADDRESS LAYOUT options. 

A. DISTANCE TO RIGHT 

B. DISTANCE TO BOTTOM 

C. LINE SPACING 
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  Printer Menu System 

D. ORIENTATION 

E. ORIENTATION CNTRL. (CONTROL) 

A. Distance 
to Right 

Distance to Right is the distance measured from the 
right edge of the media to the first printable character. 

See example. 

 

 
 

Example: 

Use the following steps to change the position of the 
record on the media. 

• Press the Enter button to select this option. 

• Press the + ( MORE ) or - ( LESS ) buttons to 
increase / decrease the distance to the right edge of 
the media.  

• Press the Enter button to select the desired 
measurement. 

• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 
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  Printer Menu System 

The Distance to Bottom is the distance between the 
bottom edge of the media and the base of the first line 
of the address. Minimum distance between the bottom 
of the last line of the address and the bottom edge of 
the media is 5/8 inches (10.58mm). If less than 5/8 
inches (10.58mm), the lower right barcode will not be 
printed. 

B. Distance 
to Bottom  

Use the following steps to change the position of the 
record on the media. 

• Press the Enter button to select this option. 

• Press the + ( MORE ) or - ( LESS ) buttons to 
increase / decrease the distance from the bottom. 

• Press the Enter button to select the desired 
measurement. 

• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 

• Press the On Line button, now the printer is ready 
for use. 

C. Line 
Spacing 

This sets the distance between lines of text. It is 
measured as the number of lines per inch of text. Note: 
Whenever changing the point size of the font, use the 
automatic line spacing option. The printer will 
automatically select the correct setting for the 
increased or decreased font size of the characters being 
printed.  

Use the following steps to change the spacing between 
line of text. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the line 
spacing options: 

A) AUTOMATIC 

B) 3 LINES / INCH 

C) 4 LINES / INCH 

D) 6 LINES / INCH 
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  Printer Menu System 

E) 8 LINES / INCH 

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 

D. 
Orientation 

This changes the direction that the print appears on the 
media.  

Use the following steps to select the orientation sub-
menus. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the 
orientation options: 

A) NORMAL 

B) INVERT 

When the Orientation is set to Normal the 
leading edge of the media is assumed to be the 
bottom with the right edge running against the 
side of the printer. These assumptions are 
necessary for a barcode to be printed on the 
lower right edge of the media/envelopes.  

a) Normal 

Use the following steps to set the direction of 
print on the media to Normal. 

• Press the Enter button to select this option. 

• Press the Menu button several times to 
back out of the Main Menu until the printer 
displays OFF LINE. 

• Press the On Line button; now the printer 
is ready for use. 

Setting the Orientation to Invert notifies the 
printer that the top of the media now enters and 
exits first, and that the media left edge will run 
along the side of the printer. Selecting this 
option automatically alters the printer’s 1. 

b) Invert 
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  Printer Menu System 

ADDRESS LAYOUT options (A. Distance to 
Left, B. Distance to Top). Note: Whenever the 
Invert option is selected the lower right barcode 
feature is disabled. The reason for this, is that 
the edge of the lower right hand side of the 
media is unknown.  

Use the following steps to set the direction of 
print on the media to Invert. 

• Press the Enter button to select this option. 

• Press the Menu button several times to 
back out of the Main Menu until the printer 
displays OFF LINE. 

• Press the On Line button; now the printer 
is ready for use. 

E. 
ORIENTATION 
CNTRL. 
(CONTROL) 

This option allows the printer to ignore the orientation 
commands sent by the computer.  

Use the following steps to select the orientation control 
sub-menus. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the 
orientation options: 

A) AUTOMATIC 

B) MANUAL 

When the Orientation Control is set to 
Automatic the printer acknowledges the 
orientation commands sent from the computer.  

a) Automatic 

Use the following steps to set the direction of 
print on the media to Automatic. 

• Press the Enter button to select this option. 

• Press the Menu button several times to 
back out of the Main Menu until the printer 
displays OFF LINE. 

• Press the On Line button; now the printer 
is ready for use. 
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  Printer Menu System 

Setting the Orientation to Manual notifies the 
printer to use the menu settings for orientation. 
Use the following steps to set the orientation 
control of the printer to Manual. 

b) Manual 

• Press the Enter button to select this option. 

• Press the Menu button several times to 
back out of the Main Menu until the printer 
displays OFF LINE. 

• Press the On Line button; now the printer 
is ready for use. 

This option changes the speed of the printer and the density of 
the characters printed on the media.  2. PRINT QUALITY 

Use the following steps to select the Print Quality sub-menus. 

• Press the + or - buttons to scroll through the Main 
Menu options until the 2. PRINT QUALITY option is 
displayed on the LCD panel. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the 2. PRINT 
QUALITY options. 

A. EXECUTIVE 

B. LETTER  

C. DRAFT 

A. 
Executive 

Executive quality is used for documents that require a 
professional appearance. This is the darkest of the 
three print qualities, the slowest print speed and uses 
the most ink.  

Use the following steps to change the quality of print 
to black. 

• Press the Enter button to select this option.  
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• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 

B. Letter Letter quality is used for documents that require a 
finished, polished appearance.  

Use the following steps to change the quality of print 
to dark gray. 

• Press the Enter button to select this option.  

• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 

C. Draft Draft quality prints documents the fastest and saves 
ink. This option offers the highest print speed and 
prints the lightest of the three print qualities. Use the 
following steps to change the quality of print to light 
gray. 

• Press the Enter button to select this option.  

• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 

Use this option to alter the fonts characteristics: typeface, 
point size, spacing, stroke weight, and style.  3. FONT 

Use the following steps to select the Font sub-menus. 

• Press the + or - buttons to scroll through the Main 
Menu options until the 3. FONT option is displayed on 
the LCD panel. 

• Press the Enter button to select this option. 
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  Printer Menu System 

• Press the + or - buttons to scroll through the 3. FONT 
options. 

Note: When A. NAME is shown on the display as a 
Menu option, press the Test button and a complete 
listing of the available fonts will be printed out in their 
typeface. 

A. NAME 

B. SIZE 

C. WIDTH  

D. BOLD 

E. ITALIC 

F. OUTLINE 

A. Name There are twelve internal distinct typefaces available 
with the printer. A typeface is the unique design of 
finishing strokes and serifs of a character set.  

Note: Press the Test button when a font name is 
displayed on the LCD. A list of the character set is 
printed in the fonts typeface. Use these same steps 
to print a character set from a font card. 

Many optional fonts are available by installing an 
optional font card. The Font card must be installed 
(Font label facing the front of the printer). Turn the 
printer power off for 10 seconds or more. Insert the 
font card, then power on the printer to use the external 
font card.  

Use the following steps to change the typeface of the 
font. 

• Press the Enter button to select this option. 
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  Printer Menu System 

• Press the + or - buttons to scroll through the A. 
Name options until the desired selection is 
displayed on the LCD panel. 

a) COURIER 

b) SAN SERIF 

c) ROMAN 

d) BAXTER 

e) DINGBAT 

f) HANCOCK 

g) MARINA 

h) QUINCY 

i) SILICON 

j) SPRINGER 

k) STENCIL 

l) WINDMILL 

 
• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 

B. Size The font Size (internal or external) can be set from 4 to 
30 point. Font sizes up to 30 Point can be downloaded 
from Microsoft Windows™ to the 13K Address Printer 
(one inch equals 72 point). The point size of this text is 
12 point. 

Use the following steps to change the size of the font. 

• Press the Enter button to select this option. 

• Press the + or - button to select + LARGER 
(increase the point size increases the character 
height) or  - SMALLER point size. 

• Press the Enter button to select the desired option. 
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  Printer Menu System 

• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 

Example: 
This is a test message in 8 point. 

This is a test message in 12 point. 

This is a Roman Text in 20 
point. 

Courier Text 
in 30 point. 

C. Width Use this option to change the width of spaces between 
characters and the width of characters. Normal (100%) 
print width is the standard width of characters and 
spaces between characters. Settings of Thin (75%) and 
Condensed (50%) will decrease the spacing between 
characters and decrease the width of characters. The 
settings of Wide (125%) and Expanded (150%) 
increase the width of characters and spaces. 

Use the following steps to change the spacing and 
width of the font. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the C. 
Width options. 

a) CONDENSED (50%) 
b) THIN    (75%) 
c) NORMAL   (100%) 
d) WIDE    (125%) 
e) EXPANDED  (150%) 
 

• Press the Enter button to select the desired option. 
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• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 

D. Bold This increases the character stroke weight (thickness of 
print).  Bold is used to emphasize or highlight text in 
an address. 

Use the following steps to bold the font. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the D. 
Bold options: ON or OFF. 

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 

E. Italic This refers to the oblique shape of a character and is 
used to emphasize text in an address.  

Use the following steps to change the font to italic. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the E. 
Italic options: ON or OFF. 

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 
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Use this option to print only the outline or the edge of 
the fonts shape. All the records printed using Outline 
will appear as hollow text. The Outline option 
will emphasize text in an address.  

F. Outline 

Use the following steps to print the font outline. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the F. 
Outline options: ON or OFF. 

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 

Use this option to position the barcode or to choose not to 
include a barcode on the piece of media. 4. BARCODE 

• Press the + or - buttons to scroll through the Main 
Menu options until the 4. BARCODE option is 
displayed on the LCD panel. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the options. 

A. LOCATION 

B. 5 DIGIT ON/OFF 

A. Location Use this option to disable printing the barcode or to 
select where to print the US Postal Service Postnet 
Barcode. 

• Press the Enter button to select this option. 
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• Press the + or - buttons to scroll through the 
Location options. 

a) LOWER RIGHT CORNER 

b) ABOVE ADDRESS 

c) BELOW ADDRESS 

d) OFF 

Use this option to print the barcode on the 
lower right edge of the media. Note: This 
option is disabled when the selected 
Orientation is Invert. 

a) Lower Right 
Corner 

• Press the Enter button to select this 
option. 

• Press the Menu button several times to 
back out of the Main Menu until the 
printer displays OFF LINE. 

• Press the On Line button; now the 
printer is ready for use. 

Use this option to print the barcode in the 
address block above the first line of the address 
on the media. 

b) Above Address 

• Press the Enter button to select this 
option. 

• Press the Menu button several times to 
back out of the Main Menu until the 
printer displays OFF LINE. 

• Press the On Line button; now the 
printer is ready for use. 

Use this option to print the barcode below the 
last line of the address in the address block on 
the media. 

c) Below Address 

• Press the Enter button to select this 
option. 

• Press the Menu button several times to 
back out of the Main Menu until the 
printer displays OFF LINE. 
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• Press the On Line button; now the 
printer is ready for use. 

Use this option to stop the printing of a 
Delivery Point Barcode (DPBC) on the media. 

d) Off 

• Press the Enter button to select this 
option. 

• Press the Menu button several times to 
back out of the Main Menu until the 
printer displays OFF LINE. 

• Press the On Line button; now the 
printer is ready for use. 

B. 5 Digit 
On / Off 

Use this option to print a 5 Digit barcode for a five 
digit zip code. Note: Only a 5 Digit barcode is printed 
for a five digit zip code when enabled. A Delivery 
Point Bar Code cannot be generated from a five digit 
zip code. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the 5 
Digit On / Off  options of ON or OFF (default 
setting is OFF). If enabled (On) a 5 digit zip code 
will be printed. 

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 

If something goes wrong while printing use this option to 
direct the printer to re-print up to 20 of the last records or to 
clear the printers memory of all records. 

5. ADDRESS 
RECOVERY 

• Press the + or - buttons to scroll through the Main 
Menu options until the 5. ADDRESS RECOVERY 
option is displayed on the LCD panel. 

• Press the Enter button to select this option. 
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• Press the + or - buttons to scroll through the Address 
Recovery options. 

A. GET ADDRESSES 

B. CLEAR MEMORY 

A. Get 
Addresses  

Use this option to retrieve up to 20 records from the 
data buffer. 

• Press the Enter button to select this option. 

• The display will say 00: and show the first 16 
characters of the last address printed. Press the 
Enter button to select the record and advance the 
display to the next to last record. Keep on pressing 
the Enter button to continue advancing back 
through the records and to select the displayed 
records. NONE TO RECOVER is displayed when 
no more records are able to be retrieved. If NONE 
TO RECOVER is first displayed then the data 
buffer is empty. 

• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. Note: The recovered records will print 
once the printer is ON LINE. 

B. Clear 
Memory 

Use this option to remove any data left in the data 
buffer.  

• Press the Enter button to select this option. 

• Press the + (YES) button to clear the printers 
memory or press the - (NO) button if you do not 
wish to clear the address data from the memory. 

• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 
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Use this option to clear the piece (batch) counter. 
6. CLEAR 
COUNTER 

• Press the + or - buttons to scroll through the Main 
Menu options until the 6. CLEAR COUNTER option 
is displayed on the LCD panel. 

• Press the Enter button to select this option. 

• Press the + (YES) button to reset the counter to zero 
or press the - (NO) button to leave the current number 
of pieces printed (PCS) on the LCD display. 

• Press the Menu button several times to back out of the 
Main Menu until the printer displays OFF LINE. 

• Press the On Line button; now the printer is ready for 
use. 

The printer has the ability to save or load up to eight different 
menu presets in memory. This is extremely useful for a quick 
setup of the printer for redundant tasks. 

7. JOB SETTINGS 

• Press the + or - buttons to scroll through the Main 
Menu options until the 7. JOB SETTINGS option is 
displayed on the LCD panel. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the 7. JOB 
SETTINGS options. 

A. LOAD 

B. SAVE 

A. Load This option is selected to retrieve the menu settings 
from a previous job setup. 

• Press the Enter button to select this option. 

• Press + MORE or - LESS to increase or decrease 
the desired job number.  

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 
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• Press the On Line button; now the printer is ready 
for use. 

B. Save  This option saves the current menu setup. The menu 
configuration is saved as a job number (1 through 8). 
The operator must keep a record of these 
configurations and the job number that was assigned. 

• Press the Enter button to select this option. 

• Press + MORE or - LESS to increase or decrease 
the desired job number. 

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of 
the Main Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 
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SETUP MENU 
Using the 
Setup Menu 

The Address Printer has a Setup Menu level that lets you 
configure the Address Printer so it will function correctly with 
the computer and computer software. Use the Setup Menu 
level to also render the menus in another language besides 
English. Hold down the Menu button for two (2) seconds until 
SETUP MENU is displayed on the first line of the LCD. 
Select the desired menu option when it appears on the second 
line of the LCD.  

These options are covered in the following pages. 

1. HEAVY MEDIA MODE 

2. TEST PRINT HEAD 

3. PURGE PRINT HEAD 

4. LINES PER ADDRESS 

5. COMMUNICATIONS 

6. HEX DUMP MODE 

7. LANGUAGES 

8. ENV. FEED DELAY 

9. ENV. AUTO EJECT 

10. ROM REVISION 

If the media stack exceeds 10 pounds (4.54 kg), use this 
option to increase the force used to feed the media. Whenever 
the transport motor torque is increased the media throughput 
will decrease approximately 10%. 

1. HEAVY MEDIA 
MODE 

Use the following steps to change the transport motor torque. 

• Press the + or - buttons to scroll through the Setup 
Menu options until the 1. HEAVY MEDIA MODE 
option is displayed on the LCD panel. 

• Press the Enter button to select this option. 
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• Press the + or - buttons to scroll through the options 
of ON or OFF. 

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of the 
Setup Menu until the printer displays OFF LINE. 

• Press the On Line button; now the printer is ready for 
use. 

Before using this option, verify the media is loaded in the 
input bin so a test pattern can be printed. A diagonal line will 
print across the media with a small solid box. If a gap is 
present within the diagonal line, one or more nozzles of the 
ink jet cartridge maybe blocked and need to be cleaned. Clean 
the ink jet cartridge by performing a purge (see menu option 
below). If the purge does not clear the nozzles, then remove 
the Ink Jet Cartridge. See chapter 4 on how to remove and 
install an ink jet cartridge. Clean the nozzles with a dry soft 
cotton cloth or one moistened with water. 

2. TEST PRINT 
HEAD 

Use the following steps to test the ink jet cartridge. 

• Press the + or - buttons to scroll through the Setup 
Menu options until the 2. TEST PRINT HEAD option 
is displayed on the LCD panel. 

• Press the Enter button to select this option. 

• The LCD will display Print a test pattern? Press the + 
(YES) button to print the test pattern or press the - 
(NO) button to disable this option. 

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of the 
Setup Menu until the printer displays OFF LINE. 

• Press the On Line button; now the printer is ready for 
use. 

The purge process fires all the ink jet nozzles to dislodge and 
clear any dried ink on the print nozzles. Often this will return 
the print quality to a normal level.  

3. PURGE PRINT 
HEAD 
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Use the following steps to clean the ink jet cartridge nozzles. 

• Press the + or - buttons to scroll through the Setup 
Menu options until the 3. PURGE PRINT HEAD 
option is displayed on the LCD panel. 

• Press the Enter button to select this option. 

• Press the + (YES) button to clear the ink jet nozzles or 
press the - (NO) button to disable this option. 

• Press the Menu button several times to back out of the 
Setup Menu until the printer displays OFF LINE. 

• Press the On Line button; now the printer is ready for 
use. 

Set the number of lines of text the record will consist of when 
printing onto the media. The printer has a range of 1 to 66 
lines.  

4. LINES PER 
ADDRESS 

Use the following steps to change the printers number of lines. 

• Press the + or - buttons to scroll through the Setup 
Menu options until the 4. LINES PER ADDRESS 
option is displayed on the LCD panel. 

• Press the Enter button to select this option. 

• Press the + button (MORE) or  -  button (LESS) to 
match the number of lines being sent to the printer. 

Note: Setting the number of lines on the printer is 
analogous to a typewriter; figure 6 lines per inch of 
text will be printed with single spacing enabled. If 
double spacing is enabled then figure 3 lines per 
inch of text will be printed. 

Commonly used settings: 

3 to 8 lines of text are commonly used for 
addresses. 

66 lines of text are typical of a 8 ½” (21.59cm) X 
11" (27.94cm) page document. 
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60 lines of text are typical of 8 ½” (21.59cm) X 
11" (27.94cm) page document with a 1/2" (1.27 
cm) top and 1/2" (1.27 cm) bottom margin. 

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of the 
Setup Menu until the printer displays OFF LINE. 

• Press the On Line button; now the printer is ready for 
use. 

Transmitting data from the computer to the printer is through 
the parallel port (parallel interface) or the serial port (serial 
interface). The printer will automatically determine the 
selection of either the SERIAL or PARALLEL interface after 
the printer has received data from the computer. When the 
computer uses the printers Parallel interface no 
communication settings are required.  

5. 
COMMUNICATIONS 

When the Serial interface is utilized the Communications 
menu settings must be configured to match the computer 
settings. The computer and printer must send and receive 
using the same configuration. Since computers typically send 
data faster than a printer can print, a “handshaking protocol” is 
employed to prevent the printers buffer from overflowing 
(communication overrun) and losing data. Set the computer to 
use one of the two methods of handshaking with the printer: 
DTR (hardware) or XON/XOFF (software). 

The following sub menus are used to change the printer serial 
communications (baud rate, parity, word length) to match the 
computers. Note: The current settings of the SERIAL menu are 
shown to the right on the LCD display. 

Use the following steps to select the Serial communications 
options. 

• Press the + or - buttons to scroll through the Setup 
Menu options until the 5. COMMUNICATIONS 
option is displayed on the LCD panel. 

• Press the Enter button to select this option. 
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• Press the + or - buttons to scroll through the options: 

A. BAUD RATE 
B. PARITY 
C. WORD LENGTH 
D. LINE TERMINATION 

A. Baud 
Rate  

Use the following steps to change the serial 
communications Baud Rate. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the Baud 
Rate options. 

a) 1200 BAUD d)  9600 BAUD 

b) 2400 BAUD e)  19200 BAUD

c) 4800 BAUD  

 

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of 
the Setup Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 

B. Parity  Use the following steps to change the serial 
communications Parity. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the 
options. 

a) ODD 

b) EVEN 

c) NONE. 

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of 
the Setup Menu until the printer displays OFF 
LINE. 
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• Press the On Line button; now the printer is ready 
for use. 

C. Word 
Length 

Use the following steps to change the serial 
communications word length. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the 
options. 

a) 7 DATA BITS 

b) 8 DATA BITS 

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of 
the Setup Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 

D. Line 
Termination 

The typical software line termination is CR = CR; LF 
= LF. If your software is not typical then the Line 
Termination can be modified. 

Use the following steps to change the line termination. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the D. 
LINE TERMINATION options. 

a) (CR = CR; LF=  LF) 

b) (CR = CR+LF; LF = LF) 

c) (CR = CR; LF = CR + LF) 

d) (CR = CR + LF; LF = CR + LF) 

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of 
the Setup Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 

Revision A 13K USERS MANUAL Section 6 -  
 P/N 90-00093-001 

26



  Printer Menu System 

The Address Printer uses two methods of sending serial data, 
XON/XOFF and DTR. The XON/XOFF software 
handshaking uses only three wires of the cable, pins 2, 3 and 
7. Software handshaking is performed by the printer when the 
buffer is nearly ready to overflow. When the buffer has room 
for only 100 more characters, the printer sends the host an 
XOFF (ASCII DC3) character to signal it to stop data 
transmission. The printer continues printing making more 
room in the buffer. When the buffer has room for 150 more 
characters, the printer sends the host an XON (ASCII DC1) 
character to resume data transmission. 

• Handshaking 
Protocol 

DTR is hardware handshaking in the Address Printer. The 
printer uses a dedicated wire DTR (pin 20) for signaling the 
host to start or stop data transmission. The printer accepts data 
from the host until it has room for only 100 more characters. 
The printer turns off DTR to the host device, indicating it to 
stop data transmission. The printer continues printing making 
more room in the buffer. When the buffer has room for 150 
more characters, the printer turns on DTR, enabling the host to 
resume data transmission.  

The MODE command must be entered each time the computer 
is turned on or it can be put into the autoexec.bat file for auto 
loading. This command directs communications to the parallel 
port and sets the computer for infinite retries so the computer 
does not "time-out" while waiting for the printer to print. The 
message "INFINITE RETRY ON PARALLEL PRINTER 
TIME-OUT" will appear on your screen. 

• Establishing 
Communications 
for IBM compatible 
DOS systems 

Use the following command for a Centronics Parallel 
Interface. 

• Type: MODE LPT1:,,P and press ENTER 

Use the following command for an RS-232-C Serial 
Interface (at 9600 baud, no parity, 8 bits, 1 stop bit and 
continuous retry on all time outs). 

• Type: MODE COM 1:9600,N,8,1,P and ENTER. 

• To verify that the computer and the printer are 
communicating, make sure the printer is on-line, type 
DIR>PRN and press ENTER. 

• Verifying 
Communications 
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6. HEX DUMP 
MODE 

Utilize this option to print the raw ASCII data (HEX Code) 
that is being sent to the printer. This is very useful when 
troubleshooting computer (software) installation problems.  

Each line printed in HEX DUMP MODE is divided 
into two sections: The left hand side is the Hex Code 
sent to the printer and the right hand side is the ASCII 
Characters that are assigned to the HEX Code. All dots 
(periods) depicted on the right hand side of the ASCII 
Characters are unprintable printer commands or printer 
characters i.e. spaces, backspace, line feed, etc. 

Hex Code appears as alpha-numeric pairs that range 
from [00] to [FF]. Reference the HEX chart in 
Appendix B for review. The HEX codes printed can be 
understood by knowing four HEX Codes:  

numerals are represented by 30's (0 is [30] 
HEX, 1 is [31] HEX, etc.) 

Carriage Return (CR) is [0D] in HEX 

Line Feed (LF) is [0A] in HEX 

Form Feed is [0C] in HEX 

To review the records printed in HEX DUMP MODE 
organize the printed HEX Code in ascending order 
using the initial two digits of the first line on each 
piece. The first piece will begin with the number 00, 
then 01, 02, etc. Look through each line of HEX Code 
to find the start of the next address or until a [0C] form 
feed is encountered. A form feed [0C] will always be 
found as the last HEX Code printed on the piece. 

Note: The media width must be a minimum of 7 1/2” 
or 191 mm when running in HEX Mode.  The page 
orientation, margins and number of lines are defined 
by the ADDRESS LAYOUT and LINES/ADDRESS. 
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Example: 
 

 HEX CODE Printed ASCII DATA Sent 
 
00 
00 01 02 03 40 41 42 04 05 06 07 08 30 31 32 33  ....@ABC.....0123 
0A 0D 61 62 63 31 32 33 20 20 10 11 40 41 42 0C  ..ABC123....@abc. 

Use the following steps to print the ASCII data being sent to 
the printer. 

• Press the + or - buttons to scroll through the Setup 
Menu options until the 6. HEX DUMP MODE option 
is displayed on the LCD panel. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the 6. HEX 
DUMP MODE options of ON or OFF. 

Note: Turning the printer 
off then on again clears the 
data buffer and shuts off the 
HEX DUMP MODE. 

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of the 
Setup Menu until the printer displays OFF LINE. 

• Press the On Line button; now the printer is ready for 
use. Note: Clear the data buffer before sending data 
to the printer. 

Customize the printer to match the keyboard of your printer, 
convert measurements from inches to millimeters and translate 
the menus from English. Use the following steps to customize 
the printer. 

7. LANGUAGE 

• Press the + or - buttons to scroll through the Setup 
Menu options until the 6. LANGUAGE option is 
displayed on the LCD panel. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the 7. 
LANGUAGE options. 
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A. SYMBOL SET 

B. INCH / MILLIMETER 

C. MENU LANGUAGE. 

A. Symbol 
Set 

The printer has International Standard Organization 
(ISO) language symbol sets to use when printing in 
another language. A symbol set contains collections of 
the symbols and characters that make up a language. 
Use the following steps to match the printers’ symbol 
set to the software. 

• Press the Enter button to select this option. 

• Press the + button or  - button to view  the   
International Standards Organization (ISO) symbol 
sets and substitution tables. Note:  

 
a) ISO 6 ANSI ASCII i)  ISO 61 NORW / DAN 
b) ISO 69 FRENCH j)  ISO 10 SWED / FIN 
c) ISO 21 GERMAN k)  ISO 16 PORTUGUESE 
d) ISO 4 UK l)  ISO 8859 
e) ISO 60 NORW / DAN m)  ROMAN 8 
f) ISO 11 SWED / FIN n)  WINDOWS LATIN 1 
g) ISO 15 ITALIAN o)  PC 8 
h) ISO 17 SPANISH  

 
• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of 
the Setup Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 

B. Inch / 
Millimeter 

This option converts the printer measurement system 
from inches to millimeters. Use the following steps to 
convert the printer measurement system from inches to 
millimeters and vice versa. 

• Press the Enter button to select this option. 

• Press the + button or  - button to scroll through the 
options of Inch or Millimeters. 
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• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of 
the Setup Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 

C. Menu 
Language 

This option will convert the Main Menu and Setup 
Menu to their translations in the following languages. 
Use the following steps to change the menu language. 

• Press the Enter button to select this option. 

• Press the + button or  - button to scroll through the 
Menu Language options. 

a) ENGLISH 
b) GERMAN 
c) FRENCH 
d) ITALIAN 
e) SPANISH 
f) DUTCH 
g) POLISH 

 
• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of 
the Setup Menu until the printer displays OFF 
LINE. 

• Press the On Line button; now the printer is ready 
for use. 

This option may be required to extend drying time for the ink 
when printing on very glossy media. This option reduces the 
overall throughput by increasing the time before the next piece 
is printed. Use the following steps to change the time between 
printing records. 

8. ENV. FEED 
DELAY 

• Press the + or - buttons to scroll through the Setup 
Menu options until the 8. ENV. FEED DELAY option 
is displayed on the LCD panel. 

• Press the Enter button to select this option. 
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• Press the + button (MORE) or  -  button (LESS) to 
increase or decrease the amount of time before the next 
piece is drawn from the input bin. The time delay can 
be set from 0.0 to 30 seconds. 

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of the 
Setup Menu until the printer displays OFF LINE. 

• Press the On Line button; now the printer is ready for 
use. 

Use this option to automatically eject the last envelope in your 
file. Use the following steps to eject a blank piece of media 
between batch jobs. 

9. ENV. AUTO 
EJECT 

• Press the + or - buttons to scroll through the Setup 
Menu options until the 9. ENV. AUTO EJECT option 
is displayed on the LCD panel. 

• Press the Enter button to select this option. 

• Press the + or - buttons to scroll through the options 
of ON or OFF. When this option is enabled a blank 
envelope will be ejected between batch jobs. 

• Press the Enter button to select the desired option. 

• Press the Menu button several times to back out of the 
Setup Menu until the printer displays OFF LINE. 

• Press the On Line button; now the printer is ready for 
use. 

This option is extremely useful whenever it is necessary to 
verify the Firmware Revision installed in the printer (i.e. for 
CASS certification) or to determine if your printer requires an 
upgrade. This also displays the total number of accumulated 
print cycles (maintenance count) which is information that can 
help to determine solutions to printer problems. Use the 
following steps to view this menu. 

10. ROM 
REVISION# 

• Press the + or - buttons to scroll through the Setup 
Menu options until the 10. ROM REVISION option is 
displayed on the LCD panel. 
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• Press the Enter button to select this option. 

The LCD will display will give a momentary view 
of the Rom Revision and the Maintenance count. 
Note: Press the Test button when ROM REV. is 
displayed on the LCD. A list of the Main Menu 
and Setup Menu settings is printed on two pieces 
of media. 
 

• Press the Menu button several times to back out of the 
Setup Menu until the printer displays OFF LINE. 

. Press the On Line button; now the printer is ready for use. 
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Preventative 
Maintenance: 

The 13K Printer is designed for trouble free service with a 
minimal amount of care. Cleaning of the Feed Rollers, Right 
Hand Slider, Left Hand Slider and Lower Guide assembly will 
be necessary. 

CLEAN INK JET CARTRIDGE, INK SURFA

ALL RUBBER ROLLERS CAN BE CLEANE
ALCOHOL OR WATER ONLY.  

USING ANY OTHER CLEANING SOLVENTS
Keep cleaning solvents with pet

Anything but ALCOHOL or WATER will cause

Lint a
over u
yellow
t  cle

Cleaning 
the Feed 
Rollers 

Cleaning 
the ink jet 
cartridges 

If the
funct
still p

The P
cycle
printi

Revision B 1
 

CAUTION!! 
CES AND COVERS WITH PLAIN WATER.  

D WITH ISOPROPYL, DENATURED & RUBBING 

 WILL VOID ALL WARRANTIES. 
roleum based products from rubber or plastic parts.  
premature breakdown of rubber compound.
nd paper dust will tend to build up on the feed rollers 
se. Clean rollers when they are glazed or have a 
ish residue. Use alcohol to dampen a soft cotton cloth 

an all rubber rollers.  
o
(17(5

(☺(&7
(1=�

7(67
(1=�

�

5L�zHJL
3�P�� 

&H���PKNL

�

21
/,1(

0(1<

 print quality is unacceptable select the Purge Print Head 
ion from the Setup Menu (see section 6 - 18). If problems 
ersist then do the following: 

• Remove the Ink Jet Cartridge (See chapter 4). 
Clean the nozzles with a soft cotton cloth. Use a dry 
cloth or one moistened with water to clean the ink jet 
cartridge. 
• Remove problem ink jet cartridge and install a 
new ink jet cartridge. 
 

rint Head Holder Assembly performs a self cleaning 
 of the Ink Jet Cartridge at the service station before 
ng and periodically while printing. 
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  Maintaining the Printer 

 
With use, a film and/or dust will build on the sensors causing 
misfeeds of media. Lift the front panel and use compressed air 
to blow dust from the sensors.  

Cleaning 
the Photo 
Sensor and 
Bracket 
Assembly 

Periodically wipe the outside and floor assembly with a soft 
damp cotton cloth (WATER ONLY). Cleaning 

the Floor 
Assembly 
and Covers 

If the slide rollers were misadjusted, it is possible to get ink 
transferred from the media onto the roller and slider surface. 
Use water to dampen a soft cloth to remove the ink from the 
rollers and slider. 

Cleaning 
the Right 
and Left 
Hand Exit 
Roller 
Sliders 
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Users Manual Symptoms & Solutions Chart 
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SYMPTOM 
 

CAUSE SOLUTION

Nothing happens when 
power is switched on 

No Power to printer. 
 
Fuse is blown 

Check Power Cord. Call Service Representative. 
 
Call Service Representative. 

LCD display shows solid 
line or miscellaneous 
characters 

Problems with miniature 
Flash Card 
 
Bad Processor Main Board 

Call Service Representative. 
 
 
Call Service Representative. 

Motor on, Feed Roller 
doesn't turn 

Loose set screw on Motor 
Pulley. 
 
Mechanical Clutch broken 
 
Broken belt 

Call Service Representative. 
 
 
Call Service Representative. 
 
Call Service Representative. 

Printer is not Feeding 
Media 

Feed Gap not set 
 
 
Media out of specification 
 

Adjust separators ("H" Blocks) to media 
thickness. 
 
Thickness: Minimum .003" (0.0762 mm), 
maximum 1/4” (6.35 mm) 
 
No metal clasps (staples, paper clips etc.) 
on media. 

Feed Problems 
(Intermittent) 

Feed Ramp not used. 
 
 
 
 
Paper dust present (yellow 
residue)? 
 

Adjust the media on the incline plane of the Feed 
Ramp. Check "H" block gap. Adjust the Wire 
Form to the correct height and in the center of the 
media.  
 
Clean roller with denatured Alcohol. Clean 
sensors 
 

Feed Problems (Multi 
feeds) 

Separators ("H" blocks) not 
set correctly 
 
Sensors dirty 
 
Brake not properly 
adjusted 

Adjust separators to media thickness 
 
 
Blow sensors clean with air. 
 
Call Service Representative. 
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SYMPTOM 
 

CAUSE SOLUTION

Print Quality Problems  
(No print) 

Ink Jet Cartridge problems  
 
 
 
 
 
Print Head Holder broken 

Purge ink jet cartridge. 
 
Clean cartridge with soft cotton cloth and water. 
 
Change to a known good cartridge. 
 
Call Service Representative. 
 

Non Uniform Print Quality Print Head Holder broken 
 

Call Service Representative. 

Ink Streaking on Media Print Head Height 
Adjustment  Knob set too 
low 
 
Ink on Exit Slider Rollers 

Turn Knob clockwise to raise the Print Head 
 
 
 
Clean Rollers with water to remove ink. 

Ink Print Quality is not 
sharp  

Print Head Height 
Adjustment Knob set too 
high 
 
Media unsuitable 

Turn Knob counterclockwise to lower the Print 
Head 
 
 
Change to a typical white wove bonded paper 

Print is Skewed 
(Skew Specification +/- 2 
1/2 degrees of bottom 
edge.) 

Wire Form set wrong 
 
Sliding Fence set wrong 
 
 
Exit Slider Rollers set 
wrong 
 
Wiper Assembly bent or 
Idler Assembly set wrong 
 

Set the Wire Form to the center of the media. 
 
Adjust the fence to within 1/16" (0.16 cm) of the 
media.  
 
Adjust exit roller to within 1/4" (6.35 mm) from 
outside edges of media. 
 
Call Service Representative. 
 
 

Print Quality Problems 
(Gray Print) 

Ink Jet Cartridge empty Ink supply too low, Replace Ink Jet Cartridge 
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SYMPTOM 
 

CAUSE SOLUTION

Print Quality Problems 
(Unwanted Bolding) 

Main Menu setting of Bold 
is enabled 
 
 
ESC sequence turning bold 
on, located before the 
address 

Press Test Button. A bold Standard Bryce Office 
Systems Address is printed. Turn Bold setting off 
in Main Menu. 
 
Do a HEX Dump of the problem address. 
Examine for ESC sequence (1B) before the start 
of the line. Reference printer command codes to 
find ESC Sequence. Remove the ESC Sequence 
from the address. 

Print Quality Problems 
(Addresses "walking") 

Incorrect address setup 
 
 
 
Number of lines of address 
varies. No Form Feed used 
for address termination. 

Do Hex Dump and count carriage returns and line 
feeds of Address Field.  Match number of lines to 
Address Setup. 
 
Check Line Termination  CR = CR, LF = LF. 
Address Termination should be Form Feed 
 

Interface problems 
(Garbage print) 

Incorrect Software Driver 
 
 
 
Wrong Symbol Set 
selected in printer. 

Typical dumb printer interface (TTY, Teletype, 
DOS text printer, Generic printer) or HP Laserjet 
series II and W700. 
 
Select correct Symbol Set from printers Setup 
Menu. 

Interface problems 
(Losing characters & lines) 

Bad communications Cable 
 
Bad main processor board 
 
RS232 -C (Serial) over 
maximum length 
 
 
Centronic (Parallel) over 
maximum length 
 
Incorrect Software Driver 

Replace internal or external cable 
 
Call Service Representative. 
 
Replace serial cable, maximum length 15 feet 
(457.2 cm) 
 
 
Replace parallel cable, maximum length 10 feet 
(304.8 cm) 
 
Use the 9K-L or 9K-LC driver with Windows 95. 
Typical dumb printer interface (TTY, Teletype, 
DOS text printer, Generic printer) or HP Laserjet 
series II and W700. 
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SYMPTOM 
 

CAUSE SOLUTION

Communication Overrun 
(Error Message) 

Bad communications Cable 
or CPU I/O 
 
Computer software 
XON/XOFF not enabled. 
 

Replace cable or Call Service Representative. 
 
 
Enable software XON / XOFF. 

Framing Error 
(Error Message) 

Incorrect Word Length / 
Parity / Baud Rate 
 

Turn printer off then back on and send data again.  
Reset settings for Baud rate in printer or 
computer. 

Parity Error 
(Error Message) 

Incorrect Parity setting 
 

Turn printer off then back on and send data again.  
Reset Parity rate in printer or computer. 

Parallel Interface, printer is 
not printing (Printer 
Halted) 

Bad data sent 
 
 
Bad communications Cable 
 
 
Bad main processor board 
 
Centronic (Parallel) Cable 
over maximum length 
 
Incorrect Software Driver 

Turn printer off, then turn printer on and send 
again. 
 
Replace parallel cable, maximum length 10 feet 
(304.8 cm) 
 
Call Service Representative. 
 
Replace parallel cable, maximum length 10 feet 
(304.8 cm) 
 
Use the 9K-L or 9K-LC driver with Windows 95. 
Typical dumb printer interface (TTY, Teletype, 
DOS text printer, Generic printer) or HP Laserjet 
series II  and W700. 
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SYMPTOM 
 

CAUSE SOLUTION

Serial Interface, printer is 
not printing 

Bad data sent 
 
 
Bad communications Cable 
 
 
Bad main processor board 
 
RS232 -C (Serial) over 
maximum length 
 
Incorrect Software Driver 

Turn printer off, then turn printer on and send 
again. 
 
Replace serial cable, maximum length 15 feet 
(457.2 cm) 
 
Call Service Representative. 
 
Replace serial cable, maximum length 15 feet 
(457.2 cm) 
 
Use the 9K-L or 9K-LC driver with Windows 95. 
Typical dumb printer interface (TTY, Teletype, 
DOS text printer, Generic printer) or HP Laserjet 
series II  and W700. 

Optional Fonts not 
functioning 

Font Cartridge not installed 
correctly 

Verify the Font Cartridge label is facing the 
operator. 
Verify the Font Cartridge is inserted all the way 
into the Font Cartridge Slot. 

Address Too High  
(Error Message) 

Software Margin incorrect Top Line of the Address is above the edge of the 
media. Move the location of the address down. 

Address Too Low  
(Error Message) 

Software Margin incorrect The Address is below the Bottom edge of the 
media. The bottom edge margin must be 
increased. 

Shuttle Jam 
(Error Message) 

Shuttle is hitting media 
 
 
Lower Print Head Shaft 
dirty. 
 
Print Head Holder 
bushings  
clogged with paper dust 

Adjust Print Head Height Adjustment knob 
clockwise, so head height is above the media. 
 
Clean shaft with alcohol and soft cotton cloth. 
 
 
Call Service Representative. 

Out of Memory 
(Error Message) 

Overuse of graphics / page 
information 

Turn printer off then send again. 

Font Card Removed 
(Error Message) 

Connection to font card 
incomplete. 

Insert Font Card, turn printer off, then turn printer 
on and send again. 
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SYMPTOM 
 

CAUSE SOLUTION

Battery Error 
(Error Message) 

Battery is low and cannot 
maintain the printers 
settings when powered 
down. 

Call Service Representative. 

No Barcode Address margin below 5/8" 
(1.6 cm) minimum distance 
 
 
Invalid Zip Code or more 
data following Zip Code. 
 
Five (5) Digit Zip Code 
turned off. 

Lower Right Barcode, the distance between the 
last line of the address field and the bottom edge 
of the media must be at least 5/8 inches (1.6 cm). 
 
Check Zip Code and correct, remove any data 
following the Zip Code. 
 
The 5 digit zip code option in the print Main 
Menu is Off. 

Barcode (lower right) is 
wandering (up and down) 

Belt tension is not adjusted 
correctly. 

Call Service Representative. 

 
Notes: ___________________________________________________________________________________  
_________________________________________________________________________________________  
_________________________________________________________________________________________  
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Appendix A • Bryce Office Systems 13K MAIN MENU Flow Chart    
 
----MAIN MENU---- 
1. Address Layout 

Address Layout 
A. Distance to Right 

DIST TO RIGHT  +MORE
*4.50 inches   -LESS

DIST TO RIGHT  +MORE
*100 mm        -LESS

   

 Address Layout 
B Distance to Bottom *2.00 inches   -LESS

DIST TO BOTTOM +MORE DIST TO BOTTOM +MORE
*50 mm         -LESS

   

 Address Layout 
C. Line Spacing 

LINE SPACING 
3 lines/inch 

LINE SPACING 
4 lines/inch 

LINE SPACING 
6 lines/inch 

LINE SPACING 
8 lines/inch 

LINE SPACING 
*Automatic 

 Address Layout 
D Orientation 

ORIENTATION 
*Normal 

ORIENTATION 
Invert 

   

 Address Layout 
E Orientation Cntrl. *AUTOMATIC 

ORIENTATION CONTROL ORIENTATION CONTROL 
MANUAL 

   

 Substituted Address Layout menu selections when ORIENTATION is in Invert.     

 Address Layout 
A. Distance to Left 

LEFT MARGIN  +MORE 
*4.50 inches   -LESS

LEFT MARGIN  +MORE 
*100 mm        -LESS

   

 Address Layout 
B Distance to Top 

TOP MARGIN    +MORE 
*2.00 inches   -LESS

TOP MARGIN    +MORE 
*50 mm         -LESS

   

       

----MAIN MENU---- 
2. Print Quality 

Print Quality 
*Executive 

Print Quality 
Letter 

Print Quality 
Draft 

   

       
----MAIN MENU---- 
3. Font 

FONT 
A. Name 

FONT NAME 
*Courier 

FONT NAME 
Sans Serif 

FONT NAME 
Roman 

FONT NAME 
Baxter 

FONT NAME 
Dingbat 

    FONT NAME
Hancock 

FONT NAME 
Marina 

FONT NAME 
Quincy 

FONT NAME 
Silicon 

FONT NAME 
Springer 

       FONT NAME
Stencil 

FONT NAME 
Windmill 

 FONT 
B. Size 

FONT SIZE    +LARGER
*12 point   -SMALLER

    

 FONT 
C. Width 

FONT WIDTH 
*Normal  (100%) 

FONT WIDTH 
Thin  (75%) 

FONT WIDTH 
Condensed  (50%) 

FONT WIDTH 
Wide  (125%) 

FONT WIDTH 
Expanded  (150%) 

 FONT 
D. Bold 

BOLD FONT 
*Off 

BOLD FONT 
On 

   

 FONT 
E. Italic 

ITALIC FONT 
*Off 

ITALIC FONT 
On 

   

 FONT 
F. Outline 

OUTLINE FONT 
*Off 

OUTLINE FONT 
On 

   

       
----MAIN MENU---- 
4. Barcode 

BARCODE 
A. Location 

BARCODE LOCATION 
*Off 

BARCODE LOCATION 
Above Address 

BARCODE LOCATION 
Below Address 

BARCODE LOCATION 
Lower Right Corner 

 

 BARCODE 
B. 5 Digit On/Off 

5 DIGIT BARCODE 
*Off 

5 DIGIT BARCODE 
On 

   

 
 To print a list of accessible fonts in their typeface, press the Test button when in the FONT menu and the 

selection A. Name is displayed. 
 
 To print a fonts’ character table, press the Test button when in the FONT NAME sub-menu and the name of the 

desired font is displayed. 
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Appendix A • Bryce Office Systems 13K MAIN MENU Flow Chart    
 

----MAIN MENU---- 
5. Address Recovery 

ADDRESS RECOVERY 
A. Get Address 

02: John P. Jones 
Hit ENTER to Recover

NONE TO RECOVER. 
 

   

 ADDRESS RECOVERY 
B. Clear Memory 

Clear the       +YES
Address Buffer? -NO 

    

       
----MAIN MENU---- 
6. Clear Counter 

Clear address   +YES 
(pcs) counter?  -NO 

Address counter 
cleared. Pieces=0 

    

       
----MAIN MENU---- 
7. Job Settings 

JOB SETTINGS 
A. Load 

Load Setting  +MORE 
from Job #3?   -LESS

Printer is set for 
Job #3. 

   

 JOB SETTINGS 
B. Save 

Save Settings  +MORE
as Job #6?     -LESS

Job #6 has been 
saved. 
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Appendix A • Bryce Office Systems 13K SETUP MENU Flow Chart  

----SETUP MENU---- 
1. Heavy Media Mode 

HEAVY MEDIA MODE 
*Off 

HEAVY MEDIA MODE 
On 

    

       
----SETUP MENU---- 
2. Test Print Head 

Print a test   +YES 
pattern?       -NO 

Please wait. Test 
pattern is printing.

     

       
----SETUP MENU---- 
3. Purge Print Head 

Purge Print    +YES 
Head?          -NO 

Please wait. Print 
head being purged. 

    

       
----SETUP MENU---- 
4. Lines Per Address *06            -LESS 

LINES/ADDRESS +MORE      

       
----SETUP MENU---- 
5. Communications 

SERIAL 
A. Baud Rate 

BAUD RATE 
1200  Baud 

BAUD RATE 
2400  Baud 

BAUD RATE 
4800  Baud 

BAUD RATE 
*9600  Baud 

BAUD RATE 
19200  Baud 

 

 SERIAL 
B. Parity 

PARITY 
*None 

PARITY 
Even 

PARITY 
Odd 

  

 SERIAL 
C. Word Length 

WORD LENGTH 
7 Data Bits 

WORD LENGTH 
*8 Data Bits 

   

 SERIAL 
D. Line Termination 

LINE TERMINATION 
*CR=CR, LF=LF 

LINE TERMINATION 
CR=CR+LF LF=LF 

LINE TERMINATION 
CR=CR LF=CR,LF 

LINE TERMINATION 
CR=CR+LF LF=CR+LF 

 

       
----SETUP MENU---- 
6. Hex Dump Mode 

HEX DUMP MODE 
*Off 

HEX DUMP MODE 
On 

        

       
----SETUP MENU---- 
7. Language 

LANGUAGE 
A. Symbol Set 

ISO CHARACTER SET 
*ISO 6 ANSI ASCII 

ISO CHARACTER SET 
ISO 69 FRENCH 

ISO CHARACTER SET 
ISO 21 GERMAN 

ISO CHARACTER SET 
ISO 4 UK 

ISO CHARACTER SET 
ISO 60 NORW / DAN 

ISO CHARACTER SET 
ISO 11 SWED / FIN 

  ISO CHARACTER SET 
ISO 15 ITALIAN 

ISO CHARACTER SET 
ISO 17 SPANISH 

ISO CHARACTER SET 
ISO 61 NOR / DAN 

ISO CHARACTER SET 
ISO 10 SWED / FIN 

ISO CHARACTER SET 
ISO 16 PORTUGUESE 

ISO CHARACTER SET 
ISO 8859 

  ISO CHARACTER SET 
ROMAN 8 

ISO CHARACTER SET 
WINDOWS LATIN 1 

ISO CHARACTER SET 
PC 8 

   

 LANGUAGE 
B. Inch/Millimeter 

MEASUREMENT UNITS 
*Inch 

MEASUREMENT UNITS 
Millimeter 

    

 LANGUAGE 
C. Menu Language 

DISPLAY LANGUAGE 
*English 

DISPLAY LANGUAGE 
German 

DISPLAY LANGUAGE 
French 

DISPLAY LANGUAGE 
Italian 

DISPLAY LANGUAGE 
Spanish 

DISPLAY LANGUAGE  
Dutch 

  DISPLAY LANGUAGE  
Polish 

    

       
----SETUP MENU---- 
8. Env. Feed Delay 

FEED DELAY    +MORE 
* 0.0 SEC.    -LESS 

     

       
----SETUP MENU---- 
9. Env. Auto Eject 

AUTO EJECT MODE 
*On 

AUTO EJECT MODE 
Off 

    

       
----SETUP MENU---- 
10. Rom Revision # 

ROM REV.   =  P72693 
MAINT COUNT=12345678 

     

 To print a list of the Main Menu and Setup Menu settings, press the Test button when ROM REV is displayed. 
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HEX CHART 
 

 
 
 
 

MSB
DECIMAL 0 16 32 48 64 80 96 112

HEX 0 1 2 3 4 5 6 7
0 0 NUL DLE SP 0 @ P  ` p

1 1 SOH DC1 ! 1 A Q a q

2 2 STX DC2 " 2 B R b r

3 3 ETX DC3 # 3 C S c s

4 4 EOT DC4 $ 4 D T d t

LSB 5 5 ENQ NAK % 5 E U e u

6 6 ACK SYN & 6 F V f v

7 7 BEL ETB  ' 7 G W g w

8 8 BS CAN ( 8 H X h x

9 9 HT EM ) 9 I Y i y

10 A LF SUB * : J Z j z

11 B VT ESC  + ; K [ k {

12 C FF FS  , < L  \ l |

13 D CR GS  -  = M ] m }

14 E SO RS . > N ^ n ~

15 F SI US  / ? O _ o DEL
       

 
 
 HEX CHART 

 
Example: The capital letter A is a HEX 41. Find the letter A on the above chart, and look towards the top of the 

chart (MSB) and the locate the HEX number 4. Then look to the left side of the chart (LSB) and 
locate the Hex number 1. Therefore the HEX number is MSB 4 and LSB 1= 41. 
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Introduction 
The 13K Address Printer emulates the listed PCL 5 printer command codes. The 13K Address Printer will 
virtually handle media as an HP1200 would using these printer commands. Additional printer commands have 
been added to allow control of special printer addressing functions and addressing needs.  

The printer command codes are sets of characters that allow your computer software to override the address 
printer menu selections as fonts, print quality, etc. so customized address formats can be created. 

PCL Command Codes 

 
 

Code Name Symbol HEX  
Value 

DEC 
Value 

Description 

Line Feed <LF> 0A 10 Causes the printer to advance the paper one line at 
current line spacing. 

Form Feed <FF> 0C 12 Causes the printer to advance the paper to the next top of 
form. 

Carriage 
Return 

<CR> 0D 13 Causes the printer to move the current print position to 
the left margin. Does not cause a paper advance. 

Escape < > 1B 27 Indicates to the printer that the characters immediately 
following are part of a printer command. 

Space <SP>  20 32 Causes the printer to move the current print position one 
character to the right. 



 Appendix C  PCL Command Codes 
 

Revision B 13K USERS MANUAL Section C - 2 
 P/N 90-00093-001 

 
PCL parameterized escape sequences 

 
Printer Feature Printer 

Command 
HEX 
Equivalent 

DEC Equivalent Description 

Initialization     
Reset E 1B 45 027 069 Defines reset conditions 
Hard Reset H 1B 48 027 072 Performs reset plus clears 

all permanent macros, 
fonts, and address 
recovery buffer 

Page Control       
Page Size Default &l0A 1B 26 6C 30 41 027 038 108 048 065  #10 Envelope values 
Page Size Executive &l1A 1B 26 6C 31 41 027 038 108 049 065 7.25 x 10.5 inches (18.3 x 

26.7 cm) 
Page Size Letter &l2A 1B 26 6C 32 41 027 038 108 050 065 8.5 x 11 inches (21.6 x 

27.9 cm) 
Page Size Legal &l3A 1B 26 6C 33 41 027 038 108 051 065 8.5 x 14 inches (21.6 x 

35.6) 
Page Size A4 &l26A 1B 26 6C 32 36 

41 
027 038 108 050 054 065 210 x 297 mm 

Page Size Mon Env &l80A 1B 26 6C 38 30 
41 

027 038 108 056 048 065 7.5 x 3.88 inches (19.1 x 
9.9 cm) 

Page Size #10 Env &l81A 1B 26 6C 38 31 
41 

027 038 108 056 049 065 9.5 x 4.1 inches (24.1 x 
10.4 cm) 

Page Size DL Env &l90A 1B 26 6C 39 30 
41 

027 038 108 057 048 065 220 x 110 mm 

Page Size C5 Env &l91A 1B 26 6C 39 31 
41 

027 038 108 057 049 065 229 x 162 mm 

Page Size B5 Env &l100A 1B 26 6C 31 30 
30 41 

027 038 108 049 048 048 
065 

238 x 104 mm 

Page Size 9.4” x 15” &l101A 1B 26 6C 31 30 
31 41 

027 038 108 049 048 049 
065 

9.4 x 15 inches (23.9 x 
38.1 cm) 

Left Margin &a#L 1B 26 61 #..# 4C 027 038 097 #..# 076 # of Columns. Defined by 
current HMI. 

Clear Horiz Margins 9 1B 39 027 057  
Top Margin &l#E 1B 26 6C #..# 45 027 038 108 #..# 069 # of Dots from origin 
Page Length  &l#P 1B 26 6C #..# 50 027 038 108 #..# 080 # of Lines 
Text Length &l#F 1B 26 6C #..# 46 027 038 108 #..# 070 # of Lines 
Horiz Motion Index 
(HMI) 

&k#H 1B 26 6B #..# 48 027 038 107 #..# 072 # of 1/120 inch (1/47 cm) 
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PCL parameterized escape sequences 

 
Printer Feature Printer 

Command 
HEX 
Equivalent 

DEC Equivalent Description 

Page Control       
Vertical Motion 
Index (VMI) 

&l#C 1B 26 6C #..# 43 027 038 108 #..# 067 # of 1/48 inch (1/19 cm) 

Line Spacing &l#D 1B 26 6C #..# 44 027 038 108 #..# 068 # of lines per inch 
Page Eject &l0H 1B 26 6C 30 48 027 038 108 048 072  
Heavy Media Mode 
OFF 

&l6H 1B 26 6C 36 48 027 038 108 054 072 Effects feed mode 
selection 

Heavy Media Mode 
ON 

&l9H 1B 26 6C 39 48 027 038 108 057 072 Effects feed mode 
selection 

Page Orientation &l0O 1B 26 6C 30 4F 027 038 108 048 079 Portrait 
 &l2O 1B 26 6C 32 4F 027 038 108 050 079 Reverse Portrait 
Dry Hold Time &b#T 1B 26 62 #..# 54 027 038 098 #..# 084 Minimum time between 

pieces in 1/10 seconds. 
Specifies time from 
leading edge to leading 
edge. 
Dflt = 0. Max. = 300 

Page Height +s#H 1B 2B 73  #..# 
48 

027 043 115  #..# 072 # = height in PCL units. 
(1/300 in.) (1/118 cm) 
Range of values is 1050 ... 
4500 
(3 to 15 in.) (7.62 to 38.1 
cm). 

Page Width  +s#W 1B 2B 73  #..# 
57 

027 043 115  #..# 087 # = width in PCL units 
(1/300 in.) (1/118 cm) 
Range of values is 1500 .. 
2820 (5 to 9.4 in.) (12.7 to 
23.9 cm). 

Cursor Positioning     
Horizontal Position &a#C 1B 26 61 #..# 43 027 038 097 #..# 067 Move to Column no. 
 *p#X 1B 2A 70 #..# 58 027 042 112 #..# 088 # of Dots 
 &a#H 1B 26 61 #..# 48 027 038 097 #..# 072 # of Decipoints (1/720 

inch) (1/283 cm) 
Vertical Position &a#R 1B 26 61 #..# 52 027 038 097 #..# 082 Move to Row no. 
 *p#Y 1B 2A 70 #..# 59 027 042 112 #..# 089 # of Dots 
 &a#V 1B 26 61 #..# 56 027 038 097 #..# 086 # of Decipoints (1/720 

inch) (1/283 cm) 
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PCL parameterized escape sequences 
 

Printer Feature Printer 
Command 

HEX 
Equivalent 

DEC Equivalent Description 

Half Line Feed = 1B 3D 027 061 Half of current VMI 
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PCL parameterized escape sequences 

 
Printer Feature Printer 

Command 
HEX 
Equivalent 

DEC Equivalent Description 

Cursor Positioning     
Line Termination &k#G    
         0 1B 26 6B 30 47 027 038 107 048 071 CR=CR, LF=LF, FF=FF 
         1 1B 26 6B 31 47 027 038 107 049 071 CR=CR+LF, LF=LF, 

FF=FF 
         2 1B 26 6B 32 47 027 038 107 050 071 CR=CR, LF=CR+LF, 

FF=CR+FF 
         3 1B 26 6B 33 47 027 038 107 051 071 CR=CR+LF, LF=CR+LF, 

FF=CR+FF 
Font Selection 
(Primary)

    

Symbol Set (ID 1B 28 # .. # 027 040 # .. #  
 (0D 1B 28 30 44 027 040 048 068 ISO 60 Norwegian ver 1 
 (0I 1B 28 30 49 027 040 048 073 ISO 15 Italian 
 (0N 1B 28 30 4E 027 040 048 078 ISO 8859 
 (0S 1B 28 30 53 027 040 048 083 ISO 11 Swedish 
 (0U 1B 28 30 55 027 040 048 085 ANSI ASCII 
 (1D 1B 28 31 44 027 040 049 068 ISO 61 Norwegian ver 2 
 (1E 1B 28 31 45 027 040 049 069 ISO 4 UK 
 (1F 1B 28 31 46 027 040 049 070 ISO 69 French 
 (1G 1B 28 31 47 027 040 049 071 ISO 21 German 
 (2S 1B 28 32 53 027 040 050 083 ISO 17 Spanish 
 (3S 1B 28 33 53 027 040 051 083 ISO 10 Swedish 
 (4S 1B 28 34 53 027 040 052 083 ISO 16 Portuguese 
 (8U 1B 28 38 55 027 040 056 085 Roman 8 
 (10U 1B 28 31 30 55 027 040 049 048 085 PC - 8 
 (12U 1B 28 31 32 55 027 040 049 050 085 PC 850 
 (19U 1B 28 31 39 55 027 040 049 057 085 Windows 3.1 Latin 
Print Quality (s#Q    
 (s0Q 1B 28 73 30 51 027 040 115 048 081 Quality = Draft 
 (s1Q 1B 28 73 31 51 027 040 115 049 081 Quality = Letter 
 (s2Q 1B 28 73 32 51 027 040 115 050 081 Quality = Executive 
Spacing  (s#P    
       0 1B 28 73 30 50 027 040 115 048 080 Fixed Spacing 
       1 1B 28 73 31 50 027 040 115 049 080 Proportional Spacing 
Height  (s#V 1B 28 73 #..# 56 027 040 115 #..# 086 Point Size #/72 inch (1/28 

cm) 
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PCL parameterized escape sequences 
 

Printer Feature Printer 
Command 

HEX 
Equivalent 

DEC Equivalent Description 

Font Selection 
(Primary) 
 

    

Style  (s#S    
       0 1B 28 73 30 53 027 040 115 048 083 Upright 
       1 1B 28 73 31 53 027 040 115 049 083 Italic 
       2 1B 28 73 32 53 027 040 115 050 083 Expanded (150%) 
       3 1B 28 73 33 53 027 040 115 051 083 Italic, Expanded (150%) 
       4 1B 28 73 34 53 027 040 115 052 083 Thin (75%) 
       5 1B 28 73 35 53 027 040 115 053 083 Italic, Thin (75%) 
       8 1B 28 73 38 53 027 040 115 056 083 Condensed (50%) 
       9 1B 28 73 39 53 027 040 115 057 083 Italic, Condensed (50%) 
       16 1B 28 73 31 36 

53 
027 040 115 049 054 083 Wide (125%) 

       17 1B 28 73 31 37 
53 

027 040 115 049 055 083 Italic, Wide (125%) 

       32 1B 28 73 33 32 
53 

027 040 115 051 050 083 Hollow 

       33 1B 28 73 33 33 
53 

027 040 115 051 051 083 Hollow, Italic 

       34 1B 28 73 33 34 
53 

027 040 115 051 052 083 Hollow, Expanded (150%)

       35 1B 28 73 33 35 
53 

027 040 115 051 053 083 Hollow, Italic, Expanded 
(150%) 

       36 1B 28 73 33 36 
53 

027 040 115 051 054 083 Hollow, Thin (75%) 

       37 1B 28 73 33 37 
53 

027 040 115 051 055 083 Hollow, Italic, Thin (75%) 

       40 1B 28 73 34 30 
53 

027 040 115 052 048 083 Hollow, Condensed (50%) 

       41 1B 28 73 34 31 
53 

027 040 115 052 049 083 Hollow, Italic, Condensed 
(50%) 

       48 1B 28 73 34 38 
53 

027 040 115 052 056 083 Hollow, Wide (125%) 

       49 1B 28 73 34 39 
53 

027 040 115 052 057 083 Hollow, Italic, Wide 
(125%) 

Stroke Weight  (s#B    
       0 1B 28 73 30 42 027 040 115 048 066 Normal 
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PCL parameterized escape sequences 
 

Printer Feature Printer 
Command 

HEX 
Equivalent 

DEC Equivalent Description 

       3 1B 28 73 33 42 027 040 115 051 066 Bold 
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PCL parameterized escape sequences 

 
Printer Feature Printer 

Command 
HEX 
Equivalent 

DEC Equivalent Description 

Font Selection 
(Primary)

    

Typeface (s#T    
       3 1B 28 73 33 54 027 040 115 051 084 Courier 
       4 1B 28 73 34 54 027 040 115 052 084 San Serif 
       5 1B 28 73 35 54 027 040 115 053 084 Roman 
       61440 1B 28 73 36 31 

34 34 30 54 
027 040 115 054 049 052 
052 048 084 

External (First) 

       61441 1B 28 73 36 31 
34 34 31 54 

027 040 115 054 049 052 
052 049 084 

External (Second) 
If available 

Font Selection     
Font Selection (#X 1B 28 #..# 58 027 040 #..# 088 Font ID # from download 
Font Selection 
(Secondary)

    

Symbol Set )ID 1B 29 # .. # 027 041 # .. #  
 )0D 1B 29 30 44 027 041 048 068 ISO 60 Norwegian ver 1 
 )0I 1B 29 30 49 027 041 048 073 ISO 15 Italian 
 )0N 1B 29 30 4E 027 041 048 078 ISO 8859 
 )0S 1B 29 30 53 027 041 048 083 ISO 11 Swedish 
 )0U 1B 29 30 55 027 041 048 085 ANSI ASCII 
 )1D 1B 29 31 44 027 041 049 068 ISO 61 Norwegian ver 2 
 )1E 1B 29 31 45 027 041 049 069 ISO 4 UK 
 )1F 1B 29 31 46 027 041 049 070 ISO 69 French 
 )1G 1B 29 31 47 027 041 049 071 ISO 21 German 
 )2S 1B 29 32 53 027 041 050 083 ISO 17 Spanish 
 )3S 1B 29 33 53 027 041 051 083 ISO 10 Swedish 
 )4S 1B 29 34 53 027 041 052 083 ISO 16 Portuguese 
 )8U 1B 29 38 55 027 041 056 085 Roman 8 
 )10U 1B 29 31 30 55 027 041 049 048 085 PC - 8 
 )12U 1B 29 31 32 55 027 041 049 050 085 PC 850 
 )19U 1B 29 31 39 55 027 041 049 057 085 Windows 3.1 Latin 
Print Quality )s#Q    
 )s0Q 1B 29 73 30 51 027 041 115 048 081 Quality = Draft 
 )s1Q 1B 29 73 31 51 027 041 115 049 081 Quality = Letter 
 )s2Q 1B 29 73 32 51 027 041 115 050 081 Quality = Executive 
Spacing  )s#P    
       0 1B 29 73 30 50 027 041 115 048 080 Fixed Spacing 
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PCL parameterized escape sequences 
 

Printer Feature Printer 
Command 

HEX 
Equivalent 

DEC Equivalent Description 

       1 1B 29 73 31 50 027 041 115 049 080 Proportional Spacing 
Font Selection 
(Secondary)

    

Height  )s#V 1B 29 73 #..# 56 027 041 115 #..# 086 Point Size #/72 inch (1/28 
cm) 

Style  )s#S    
       0 1B 29 73 30 53 027 041 115 048 083 Upright 
       1 1B 29 73 31 53 027 041 115 049 083 Italic 
       2 1B 29 73 32 53 027 041 115 050 083 Expanded (150%) 
       3 1B 29 73 33 53 027 041 115 051 083 Italic, Expanded (150%) 
       4 1B 29 73 34 53 027 041 115 052 083 Thin (75%) 
       5 1B 29 73 35 53 027 041 115 053 083 Italic, Thin (75%) 
       8 1B 29 73 38 53 027 041 115 056 083 Condensed (50%) 
       9 1B 29 73 39 53 027 041 115 057 083 Italic, Condensed (50%) 
       16 1B 29 73 31 36 

53 
027 041 115 049 054 083 Wide (125%) 

       17 1B 29 73 31 37 
53 

027 041 115 049 055 083 Italic, Wide (125%) 

       32 1B 29 73 33 32 
53 

027 041 115 051 050 083 Hollow 

       33 1B 29 73 33 33 
53 

027 041 115 051 051 083 Hollow, Italic 

       34 1B 29 73 33 34 
53 

027 041 115 051 052 083 Hollow, Expanded (150%)

       35 1B 29 73 33 35 
53 

027 041 115 051 053 083 Hollow, Italic, Expanded 
(150%) 

       36 1B 29 73 33 36 
53 

027 041 115 051 054 083 Hollow, Thin (75%) 

       37 1B 29 73 33 37 
53 

027 041 115 051 055 083 Hollow, Italic, Thin (75%) 

       40 1B 29 73 34 30 
53 

027 041 115 052 048 083 Hollow, Condensed (50%) 

       41 1B 29 73 34 31 
53 

027 041 115 052 049 083 Hollow, Italic, Condensed 
(50%) 

       48 1B 29 73 34 38 
53 

027 041 115 052 056 083 Hollow, Wide (125%) 

       49 1B 29 73 34 39 53 027 041 115 052 057 083 Hollow, Italic, Wide (125%) 
Stroke Weight  )s#B    
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PCL parameterized escape sequences 
 

Printer Feature Printer 
Command 

HEX 
Equivalent 

DEC Equivalent Description 

       0 1B 29 73 30 42 027 041 115 048 066 Normal 
       3 1B 29 73 33 42 027 041 115 051 066 Bold 
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PCL parameterized escape sequences 

 
Printer Feature Printer 

Command 
HEX 
Equivalent 

DEC Equivalent Description 

Font Selection 
(Secondary)

    

Typeface )s#T    
       3 1B 29 73 33 54 027 041 115 051 084 Courier 
       4 1B 29 73 34 54 027 041 115 052 084 San Serif 
       5 1B 29 73 35 54 027 041 115 053 084 Roman 
       61440 1B 29 73 36 31 

34 34 30 54 
027 041 115 054 049 052 
052 048 084 

External (First) 

       61441 1B 29 73 36 31 
34 34 31 54 

027 041 115 054 049 052 
052 049 084 

External (Second) 
If available 

Underline     
Underline &d#D    
Underline On     0 1B 26 64 30 44 027 038 100 48 068  
Underline On     3 1B 26 64 33 44 027 038 100 51 068  
Underline Off &d@ 1B 26 64 40 027 038 100 064  
Macros      
Macro ID &f#Y 1B 26 66 #..# 59 027 038 102 #..# 089 # is macro ID 
Macro Control &f#X    
        0 1B 26 66 30 58 027 038 102 048 088 Start macro definition (last 

ID specified) 
        1 1B 26 66 31 58 027 038 102 049 088 Stop macro definition 
        2 1B 26 66 32 58 027 038 102 050 088 Execute Macro  (last ID 

specified). Use current 
modified print 
environment. Changes 
retained on completion 

        3 1B 26 66 33 58 027 038 102 051 088 Call Macro (last ID 
specified). Use current 
modified print 
environment. Restore 
prior environment on 
completion. 

        4 1B 26 66 34 58 027 038 102 052 088 Enable macro for auto 
overlay (last ID specified) 

        5 1B 26 66 35 58 027 038 102 053 088 Disable auto overlay 
        6 1B 26 66 36 58 027 038 102 054 088 Delete all Macros 
        7 1B 26 66 37 58 027 038 102 055 088 Delete all temp macros 
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PCL parameterized escape sequences 
 

Printer Feature Printer 
Command 

HEX 
Equivalent 

DEC Equivalent Description 

        8 1B 26 66 38 58 027 038 102 056 088 Delete Macro (last ID 
specified) 

        9 1B 26 66 39 58 027 038 102 057 088 Make macro temp (last ID 
specified) 

        10 1B 26 66 31 30 
58 

027 038 102 049 048 088 Make macro perm (last ID 
specified) 

Programming     
Hex Dump Mode 
ON 

Y 1B 59 027 089 Data printed as hex 
numbers, ESC and 
Control codes not 
executed. 

Hex Dump Mode 
OFF 

Z 1B 5A 027 090  

Font Management     
Assign Font ID # *c#D 1B 2A 63 #..# 44 027 042 099 #..# 068 # is Font ID 
Font Control *c#F    
       0 1B 2A 63 30 46 027 042 099 048 070 Delete all Fonts 
       1 1B 2A 63 31 46 027 042 099 049 070 Delete temp fonts 
       2 1B 2A 63 32 46 027 042 099 050 070 Delete last font 
       3 1B 2A 63 33 46 027 042 099 051 070 Delete Character 
       4 1B 2A 63 34 46 027 042 099 052 070 Make font temp 
       5 1B 2A 63 35 46 027 042 099 053 070 Make font permanent 
Soft Font Creation      
Font Descriptor )s#W 

[data] 
1B 29 73 #..# 57 
data 

027 041 115 #..# 087 data Laser Jet soft fonts are 
supported. These fonts 
always have a 64 byte 
descriptor. Desk Jet fonts 
are not supported. 

Character Code *c#E 1B 2A 63 #..# 45 027 042 099 #..# 069 ASCII code no. 
Download Character (s#W 

[data] 
1B 28 73 #..# 57 
data 

027 040 115 #..# 087 data  

Raster Graphics     
Raster Graphics 
Compression 

*b#M    

 0 1B 2A 62 30 4D 027 042 098 048 077 Uncompressed format 
 2 1B 2A 62 32 4D 027 042 098 050 077 TIFF format rev. 4.0 
 3 1B 2A 62 33 4D 027 042 098 051 077 Delta Row compression 
 4 1B 2A 62 34 4D 027 042 098 052 077 Reserved  
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PCL parameterized escape sequences 
 

Printer Feature Printer 
Command 

HEX 
Equivalent 

DEC Equivalent Description 

Transfer graphics by 
plane

*b #V 1B 2A 62 # 56 
[data] 

027 042 098 # 086 [data] Transfer a row of Raster 
Data to printer, # specifies 
the number of bytes to 
follow V. The format of 
the bytes is expected to be 
in the current compression 
mode. The number of 
commands expected is the 
number of planes in the 
current palette. 

Transfer Raster 
Graphics data

*b#W 
[data] 

1B 2A 62 #..# 57 
[data] 

027 042 098 #..# 087 
[data] 

Transfer a Row of Taster 
Data to printer, # specifies 
the number of bytes to 
follow W. The format of 
the bytes is expected to be 
in the current compression 
mode. Move the cursor 
one raster line after 
printing the raster data. 
Use command to send the 
last plane of raster data. 

Raster Y Offset *b #Y 
[data] 

1B 2A 62 #..# 59 
[data] 

027 042 098 #..# 089 
[data] 

Move vertically from 
current postion by the 
specified number of dots 

     
Start Raster Graphics *r#A    
 0 1B 2A 72 30 41 027 042 114 048 065 Place to left most position 
 1 1B 2A 72 31 41 027 042 114 049 065 Place at current position 
     
End Raster Graphics     
 *rB 1B 2A 72 42 027 042 114 066  
 *rC 1B 2A 72 43 027 042 114 067 Resets left margin to 0 
Set Raster Graphics 
Width

*r#S 1B 2A 72 #..# 53 027 042 114 #..# 083 Set number of pixels 

Set Raster Graphics 
Height 

*r#T 1B 2A 72 # 54 027 042 114 # 084 Height is raster rows 

Simple Color *r#U   Default = 1. 
 

Black pallet 1 1B 2A 72 31 55 027 042 114 049 085 1 plane  
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PCL parameterized escape sequences 
 

Printer Feature Printer 
Command 

HEX 
Equivalent 

DEC Equivalent Description 

Raster Graphics 
Resolution

*t#R    

 75 1B 2A 72 37 35 
52 

027 042 116 055 055 082 75 dots per inch 

 150 1B 2A 72 31 35 
30 52 

027 042 116 049 053 048 
082 

150 dots per inch 

 300 1B 2A 72 33 30 
30 52 

027 042 116 051 048 048 
082 

300 dots per inch 

 The Page Width & Page Length printer commands function like the Page Size command. Using these 
commands automatically enables Page Eject and disables overlay macros. Both the Page Width and Page 
Length commands can be used independently and will only change the width or length to the maximum 
allowable page size of 9.4 x 15 inches (23.9 x 38.1 cm). Setting the cursor positioning commands, margin 
settings, print data, etc. to cause printing beyond the pages size dimensions will be cropped.  

 Only one overlay macro can be used at a time, and cannot be recursive. The overlay macros need print 
quality,  page parameters, etc.  to determine the printers’ page setup. 

 Soft font creation is in HP non compressed Bit Map Font Format. 

 The resident fonts are scaleable from 8 to 30 points. If a desired font spacing does not match the font 
selected an internal font will be substituted. For fixed spacing the substitute font will be Courier, and Sans Serif 
for proportionally spaced fonts. Characteristics of the font being replaced, such as point size, print width, etc., 
will be matched by the substituted font.  

 
To determine page size or cusor movement in Dots multiply by 300 Dots /inch (2.54 cm) for Horizontal and 
300 Dots /inch (2.54 cm) for Vertical. Example: a Letter size page of 8.5 x 11 inches (21.6 x 27.9 cm) is 2550 x 
3300 Dots 
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PCL parameterized escape sequences 

To utilize the 13K address printers internal bar-coding features, records are searched for a valid ZIP, ZIP + 4, 
Delivery Point Bar Code (DPBC) or DPBC with a check sum. For ZIP + 4 or a 11 digit DPBC, a checksum is 
computed for printing a USPS Postnet bar-code with framing bars. The position of the Postnet bar-code is 
determined by the printers menu setup or the bar-code location commands in effect. Bar-codes will not be 
printed outside of the printers’ Page Size setup. 
 
Printer Feature Printer 

Command 
HEX 
Equivalent 

DEC 
Equivalent 

Description 

Bar Code     
Non  - address data 
markers  

+b#A   Marks data that is not part 
of destination address. 

       1 1B 2B 62 31 41 027 043 098 49 065 marks the end of non-
address data 

       2 1B 2B 62 32 41 027 043 098 50 065 marks the beginning of 
the non-address data. 

5 Digit Bar Codes +b#D    
       0 1B 2B 62 30 44 027 043 098 048 068 Don’t print 5 Digit Bar 

Codes 
       1 1B 2B 62 31 44 027 043 098 049 068 Print all Bar Codes for 

zip, zip + 4, and DPBC. 
Bar Code +b#E    
       0 1B 2B 62 30 45 027 043 098 048 069 Disable Bar Code 
       1 1B 2B 62 31 45 027 043 098 049 069 Enable Bar Code 
Bar Code - 
Horizontal 

+b#H 1B 2B 62 #..# 48 027 043 098 #..# 072 # of Decipoints 
(1/720 inch) (1/283 cm) 

Bar Code Placement +b#P 1B 2B 62 #..# 50 027 043 098 #..# 080 Distance in 1/10 inch (1/4 
cm) units from right edge 
of media. Value of 0 
indicates edge of media 

       0 1B 2B 62 30 50 027 043 098 048 080 Bar Code in lower right 
(default position) 

       1 1B 2B 62 31 50 027 043 098 049 080 Bar Code above address 
       2 1B 2B 62 32 50 027 043 098 050 080 Bar Code below address 

       3 1B 2B 62 33 50 027 043 098 051 080 Print Bar Code at specified 
horizontal & vertical 
position, otherwise print 
Bar Code in default 
position 
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PCL parameterized escape sequences 

Printer Feature Printer 
Command 

HEX 
Equivalent 

DEC 
Equivalent 

Description 

Bar Code     
Bar Code - Vertical  +b#V 1B 2B 62 #..# 56 027 043 098 #..# 086 VMI # in Decipoints 

(1/720 inch) from bottom 
of page to bottom of bar-
code  

ZIP Code command 
Bar Code -  

+b#Znnn 1B 2B 62 #..# 
5A nnn 

027 043 098 #..# 090 nnn #= number of characters in 
the ZIP Code string.  
n = the ASCII 
representation of the ZIP 
code string. 

 +b5Z 
nnnnn 

1B 2B 62 35 5A 
nnnnn 

027 043 098 053 090 
nnnnn 

n = the ASCII 
representation of the ZIP 
code string. Must contain 5 
digits. 
 

 +b9Z 
nnnnnnnnn 

1B 2B 62 39 5A 
nnnnnnnnn 

027 043 098 057 090 
nnnnnnnnn 

n = the ASCII 
representation of the ZIP 
code string. Must contain 9 
digits. 
 

 +b11Z 
nnnnnnnnnn
n 

1B 2B 62 31 31 
5A 
nnnnnnnnnnn 

027 043 098 49 49 090 
nnnnnnnnnnn 

n = the ASCII 
representation of the ZIP 
code string. Must contain 
11 digits. 
 

 +b12Z 
nnnnnnnnnn
nn 

1B 2B 62 31 32 
5A 
nnnnnnnnnnnn 

027 043 098 049 050 090 
nnnnnnnnnnnn 

n = the ASCII 
representation of the ZIP 
code string. Must contain 
12 digits. 
 

 
 Use a pair of escape sequences, the first one before the data that is not part of the destination address 

such as return addresses, graphics, messages, etc. and the other to mark the end. 
 

 Use Zip Code command when two ZIP codes are being sent. The first ZIP code will be printed without a 
bar-code. The second ZIP code in the Zip Code command string will print a corresponding bar-code but 
not print the ZIP code. The Zip Code command only overrides the bar-code command for the present 
address. 
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 Use the +b#H and +b#V commands to position the bar code. Measure the position from the right-
hand corner of the leading edge of the media, not the upper left-hand corner. 
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13K CHARACTER SET 
 (Modeled after  PC 850 Character Table) 

 
0 

 
16 

<SP> 
32 

0 
48 

@ 
64 

P 
80 

` 
96 

p 
112

Ç 
128

É 
144

á 
160

░ 
176

└ 
192 

ð 
208 

Ó 
224 

- 
240

 
1 

 
17 

! 
33 

1 
49 

A 
65 

Q 
81 

a 
97 

q 
113

ü 
129

æ 
145

í 
161

▒ 
177

┴ 
193 

Ð 
209 

ß 
225 

± 
241

 
2 

 
18 

" 
34 

2 
50 

B 
66 

R 
82 

b 
98 

r 
114

é 
130

Æ 
146

ó 
162

▓ 
178

┬ 
194 

Ê 
210 

Ô 
226 

 
242

 
3 

 
19 

# 
35 

3 
51 

C 
67 

S 
83 

c 
99 

s 
115

â 
131

ô 
147

ú 
163

│ 
179

├ 
195 

Ë 
211 

Ò 
227 

 
243

 
4 

 
20 

$ 
36 

4 
52 

D 
68 

T 
84 

d 
100

t 
116

ä 
132

ö 
148

ñ 
164

┤ 
180

─ 
196 

È 
212 

õ 
228 

¶ 
244

 
5 

 
21 

% 
37 

5 
53 

E 
69 

U 
85 

e 
101

u 
117

à 
133

ò 
149

Ñ 
165

Á 
181

┼ 
197 

 
213 

Õ 
229 

§ 
245

 
6 

 
22 

& 
38 

6 
54 

F 
70 

V 
86 

f 
102

v 
118

å 
134

û 
150

ª 
166

Â 
182

ã 
198 

Í 
214 

µ 
230 

 
246

 
7 

 
23 

' 
39 

7 
55 

G 
71 

W 
87 

g 
103

w 
119

ç 
135

ù 
151

° 
167

À 
183

Ã 
199 

Î 
215 

Þ 
231 

¸ 
247

 
8 

 
24 

( 
40 

8 
56 

H 
72 

X 
88 

h 
104

x 
120

ê 
136

ÿ 
152

¿ 
168

© 
184

╚ 
200 

Ï 
216 

þ 
232 

º 
248

 
9 

 
25 

) 
41 

9 
57 

I 
73 

Y 
89 

i 
105

y 
121

ë 
137

Ö 
153

® 
169

╣ 
185

╔ 
201 

┘ 
217 

Ú 
233 

¨ 
249

<LF> 
10 

 
26 

* 
42 

: 
58 

J 
74 

Z 
90 

j 
106

z 
122

è 
138

Ü 
154

 
170

║ 
186

╩ 
202 

┌ 
218 

Û 
234 

• 
250

 
11 

<ESC> 
 

27 
+ 
43 

; 
59 

K 
75 

[ 
91 

k 
107

{ 
123

ï 
139

ø 
155

½ 
171

╗ 
187

╦ 
203 

█ 
219 

Ù 
235 

 
251

<FF> 
12 

 
28 

, 
44 

< 
60 

L 
76 

\ 
92 

l 
108

| 
124

î 
140

£ 
156

 
172

╝ 
188

╠ 
204 

▄ 
220 

 
236 

 
252

<CR> 
13 

 
29 

- 
45 

= 
61 

M 
77 

] 
93 

m 
109

} 
125

ì 
141

Ø 
157

¡ 
173

¢ 
189

═ 
205 

| 
221 

 
237 

 
253

 
14 

 
30 

. 
46 

> 
62 

N 
78 

^ 
94 

n 
110

~ 
126

Ä 
142

 
158

« 
174

¥ 
190

╬ 
206 

Ì 
222 

¯ 
238 

 
254

 
15 

 
31 

/ 
47 

? 
63 

O 
79 

_ 
95 

o 
111

 
127

Å 
143

ƒ 
159

» 
175

┐ 
191

¤ 
207 

▀ 
223 

´ 
239 

™ 
255

International Character Substitution 
The following industry standard character substitution techniques are utilized: 

ISO 
# 

Character 
Set Name 

ID 
# 

35 36 64 91 92 93 94 96 123 124 125 126 

6 ANSI ASCII 0U # $ @ [ \ ] ^ ` { | } ~ 
69 French 1F £ $ à ° ç § ^ µ é ù è ¨ 
21 German 1G # $ § Ä Ö Ü ^ ` ä ö ü ß 
4 United Kingdom 1E £ $ @ [ \ ] ^ ` { | } ¯ 
60 Norwegian/Danish 0D # $ @ Æ Ø Å ^ ` æ ø å ¯ 
11 Swedish/Finnish 0S # ¤ É Ä Ö Å Ü é ä ö å ü 
15 Italian 0I £ $ § ° ç é ^ ù à ò è ì 
17 Spanish 2S £ $ § ¡ Ñ ¿ ^ ` ° ñ ç ~ 
61  Norwegian/Danish 1D § $ @ Æ Ø Å ^ ` æ ø å | 
16  Portuguese 4S # $ § Ã Ç Õ ^ ` ã ç õ ° 
10  Swedish 3S # ¤ @ Ä Ö Å ^ ` ä ö å ¯ 
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13K CHARACTER SET 
 (Modeled after 8859 Latin Character Table) 

 
 

0 
 

16 
<SP> 
32 

0 
48 

@ 
64 

P 
80 

` 
96 

p 
112

 
128

 
144

 
160

° 
176

À 
192 

Ð 
208 

à 
224 

ð 
240

 
1 

 
17 

! 
33 

1 
49 

A 
65 

Q 
81 

a 
97 

q 
113

 
129

 
145

¡ 
161

± 
177

Á 
193 

Ñ 
209 

á 
225 

ñ 
241

 
2 

 
18 

" 
34 

2 
50 

B 
66 

R 
82 

b 
98 

r 
114

 
130

 
146

¢ 
162

 
178

Â 
194 

Ò 
210 

â 
226 

ò 
242

 
3 

 
19 

# 
35 

3 
51 

C 
67 

S 
83 

c 
99 

s 
115

 
131

 
147

£ 
163

 
179

Ã 
195 

Ó 
211 

ã 
227 

ó 
243

 
4 

 
20 

$ 
36 

4 
52 

D 
68 

T 
84 

d 
100

t 
116

 
132

 
148

¤ 
164

´ 
180

Ä 
196 

Ô 
212 

ä 
228 

ô 
244

 
5 

 
21 

% 
37 

5 
53 

E 
69 

U 
85 

e 
101

u 
117

 
133

 
149

¥ 
165

µ 
181

Å 
197 

Õ 
213 

å 
229 

õ 
245

 
6 

 
22 

& 
38 

6 
54 

F 
70 

V 
86 

f 
102

v 
118

 
134

 
150

¦ 
166

¶ 
182

Æ 
198 

Ö 
214 

æ 
230 

ö 
246

 
7 

 
23 

' 
39 

7 
55 

G 
71 

W 
87 

g 
103

w 
119

 
135

 
151

§ 
167

• 
183

Ç 
199 

 
215 

ç 
231 

 
247

 
8 

 
24 

( 
40 

8 
56 

H 
72 

X 
88 

h 
104

x 
120

 
136

 
152

¨ 
168

¸ 
184

È 
200 

Ø 
216 

è 
232 

ø 
248

 
9 

 
25 

) 
41 

9 
57 

I 
73 

Y 
89 

i 
105

y 
121

 
137

 
153

© 
169

 
185

É 
201 

Ù 
217 

é 
233 

ù 
249

<LF> 
10 

 
26 

* 
42 

: 
58 

J 
74 

Z 
90 

j 
106

z 
122

 
138

 
154

a 
170

 
186

Ê 
202 

Ú 
218 

ê 
234 

ú 
250

 
11 

<ESC> 
 

27 
+ 
43 

; 
59 

K 
75 

[ 
91 

k 
107

{ 
123

 
139

 
155

« 
171

» 
187

Ë 
203 

Û 
219 

ë 
235 

û 
251

<FF> 
12 

 
28 

, 
44 

< 
60 

L 
76 

\ 
92 

l 
108

| 
124

 
140

 
156

 
172

 
188

Ì 
204 

Ü 
220 

ì 
236 

ü 
252

<CR> 
13 

 
29 

- 
45 

= 
61 

M 
77 

] 
93 

m 
109

} 
125

 
141

 
157

- 
173

½ 
189

Í 
205 

 
221 

í 
237 

 
253

 
14 

 
30 

. 
46 

> 
62 

N 
78 

^ 
94 

n 
110

~ 
126

 
142

 
158

® 
174

 
190
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31 
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47 
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63 
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79 
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ÿ 
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The ID# for the ISO 8859 Character Set is (0N). 
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13K CHARACTER SET 
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0 
 

16 
<SP> 
32 

0 
48 

@ 
64 

P 
80 

` 
96 

p 
112

 
128

 
144

 
160

¯ 
176

â 
192 

Å 
208 

Á 
224 

þ 
240

 
1 

 
17 

! 
33 

1 
49 

A 
65 

Q 
81 

a 
97 

q 
113

 
129

 
145

À 
161

 
177

ê 
193 

î 
209 

Ã 
225 

Þ 
241

 
2 

 
18 

" 
34 

2 
50 

B 
66 

R 
82 

b 
98 

r 
114

 
130

 
146

Â 
162

 
178

ô 
194 

Ø 
210 

ã 
226 

· 
242

 
3 

 
19 

# 
35 

3 
51 

C 
67 

S 
83 

c 
99 

s 
115

 
131

 
147

È 
163

º 
179

û 
195 

Æ 
211 

Ð 
227 

µ 
243

 
4 

 
20 

$ 
36 

4 
52 

D 
68 

T 
84 

d 
100

t 
116

 
132

 
148

Ê 
164

Ç 
180

á 
196 

å 
212 

ð 
228 

¶ 
244

 
5 

 
21 

% 
37 

5 
53 

E 
69 

U 
85 

e 
101

u 
117

 
133

 
149

Ë 
165

ç 
181

é 
197 

í 
213 

Í 
229 

 
245

 
6 

 
22 

& 
38 

6 
54 

F 
70 

V 
86 

f 
102

v 
118

 
134

 
150

Î 
166

Ñ 
182

ó 
198 

ø 
214 

Í 
230 

– 
246

 
7 

 
23 

' 
39 

7 
55 

G 
71 

W 
87 

g 
103

w 
119

 
135

 
151

Ï 
167

ñ 
183

ú 
199 

æ 
215 

Ó 
231 

 
247

 
8 

 
24 

( 
40 

8 
56 

H 
72 

X 
88 

h 
104

x 
120

 
136

 
152

´ 
168

¡ 
184

à 
200 

Ä 
216 

Ò 
232 

½ 
248

 
9 

 
25 

) 
41 

9 
57 

I 
73 

Y 
89 

i 
105

y 
121

 
137

 
153

 
169

¿ 
185

è 
201 

ì 
217 

Õ 
233 

ª 
249

<LF> 
10 

 
26 

* 
42 

: 
58 

J 
74 

Z 
90 

j 
106

z 
122

 
138

 
154

^ 
170

¤ 
186

ò 
202 

Ö 
218 

õ 
234 

º 
250

 
11 

<ESC> 
 

27 
+ 
43 

; 
59 

K 
75 

[ 
91 

k 
107

{ 
123

 
139

 
155

¨ 
171

£ 
187

ù 
203 

Ü 
219 

Š 
235 

« 
251

<FF> 
12 

 
28 

, 
44 

< 
60 

L 
76 

\ 
92 

l 
108

| 
124

 
140

 
156

 
172

¥ 
188

ä 
204 

É 
220 

š 
236 

 
252

<CR> 
13 

 
29 

- 
45 

= 
61 

M 
77 

] 
93 

m 
109

} 
125

 
141

 
157

Ù 
173

§ 
189

ë 
205 

ï 
221 

Ú 
237 

» 
253

 
14 

 
30 

. 
46 

> 
62 

N 
78 

^ 
94 

n 
110

~ 
126

 
142

 
158

Û 
174

ƒ 
190

ö 
206 

ß 
222 

Ÿ 
238 

± 
254

 
15 

 
31 

/ 
47 

? 
63 

O 
79 

_ 
95 

o 
111

 
127

 
143

 
159

£ 
175

¢ 
191

ü 
207 

Ô 
223 

ÿ 
239 

 
255

 
The ID# for the Roman 8 Character Set is (8U). 
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13K CHARACTER SET 
 (Modeled after Windows 3.1 Latin Character Table) 

 
 

0 
 

16 
<SP> 
32 

0 
48 

@ 
64 

P 
80 

` 
96 

p 
112

 
128

 
144

 
160

° 
176

À 
192 

Ð 
208 

à 
224 

ð 
240

 
1 

 
17 

! 
33 

1 
49 

A 
65 

Q 
81 

a 
97 

q 
113

 
129

 
145

¡ 
161

± 
177

Á 
193 

Ñ 
209 

á 
225 

ñ 
241

 
2 

 
18 

" 
34 

2 
50 

B 
66 

R 
82 

b 
98 

r 
114

‚ 
130

 
146

¢ 
162

 
178

Â 
194 

Ò 
210 

â 
226 

ò 
242

 
3 

 
19 

# 
35 

3 
51 

C 
67 

S 
83 

c 
99 

s 
115

ƒ 
131

“ 
147

£ 
163

 
179

Ã 
195 

Ó 
211 

ã 
227 

ó 
243

 
4 

 
20 

$ 
36 

4 
52 

D 
68 

T 
84 

d 
100

t 
116

 
132

” 
148

¤ 
164

´ 
180

Ä 
196 

Ô 
212 

ä 
228 

ô 
244

 
5 

 
21 

% 
37 

5 
53 

E 
69 

U 
85 

e 
101

u 
117

 
133

• 
149

¥ 
165

µ 
181

Å 
197 

Õ 
213 

å 
229 

õ 
245

 
6 

 
22 

& 
38 

6 
54 

F 
70 

V 
86 

f 
102

v 
118

 
134

– 
150

¦ 
166

¶ 
182

Æ 
198 

Ö 
214 

æ 
230 

ö 
246

 
7 

 
23 

' 
39 

7 
55 

G 
71 

W 
87 

g 
103

w 
119

 
135

— 
151

§ 
167

· 
183

Ç 
199 

 
215 

ç 
231 

 
247

 
8 

 
24 

( 
40 

8 
56 

H 
72 

X 
88 

h 
104

x 
120

^ 
136

 
152

¨ 
168

¸ 
184

È 
200 

Ø 
216 

è 
232 

ø 
248

 
9 

 
25 

) 
41 

9 
57 

I 
73 

Y 
89 

i 
105

y 
121

 
137

™ 
153

© 
169

 
185

É 
201 

Ù 
217 

é 
233 

ù 
249

<LF> 
10 

 
26 

* 
42 

: 
58 

J 
74 

Z 
90 

j 
106

z 
122

Š 
138

š 
154

ª 
170

 
186

Ê 
202 

Ú 
218 

ê 
234 

ú 
250

 
11 

<ESC> 
 

27 
+ 
43 

; 
59 

K 
75 

[ 
91 

k 
107

{ 
123

 
139

 
155

« 
171

» 
187

Ë 
203 

Û 
219 

ë 
235 

û 
251

<FF> 
12 

 
28 

, 
44 

< 
60 

L 
76 

\ 
92 

l 
108

| 
124

 
140

 
156

 
172

 
188

Ì 
204 

Ü 
220 

ì 
236 

ü 
252

<CR> 
13 

 
29 

- 
45 

= 
61 

M 
77 

] 
93 

m 
109

} 
125

 
141

 
157

- 
173

½ 
189

Í 
205 

 
221 

í 
237 

 
253

 
14 

 
30 

. 
46 

> 
62 

N 
78 

^ 
94 

n 
110

~ 
126

 
142

 
158

® 
174

 
190

Î 
206 

Þ 
222 

î 
238 

þ 
254

 
15 

 
31 

/ 
47 

? 
63 

O 
79 

_ 
95 

o 
111

 
127

 
143

Ÿ 
159

¯ 
175

¿ 
191

Ï 
207 

ß 
223 

ï 
239 

ÿ 
255

 
The ID# for the Windows 3.1 Latin Character Set is (19U). 
The Windows 3.1 Latin symbol set is recommended to use when running Microsoft Windows 3.1 / Windows 95. 
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13K CHARACTER SET 
 (Modeled after PC - 8 Character Table) 

 
 

0 
 

16 
<SP> 
32 

0 
48 

@ 
64 

P 
80 

` 
96 

p 
112

Ç 
128

É 
144

á 
160

░ 
176

└ 
192 

 
208 

 
224 

 
240

 
1 

 
17 

! 
33 

1 
49 

A 
65 

Q 
81 

a 
97 

q 
113

ü 
129

æ 
145

í 
161

▒ 
177

┴ 
193 

 
209 

 
225 

± 
241

 
2 

 
18 

" 
34 

2 
50 

B 
66 

R 
82 

b 
98 

r 
114

é 
130

Æ 
146

ó 
162

▓ 
178

┬ 
194 

 
210 

 
226 

 
242

 
3 

 
19 

# 
35 

3 
51 

C 
67 

S 
83 

c 
99 

s 
115

â 
131

ô 
147

ú 
163

│ 
179

├ 
195 

 
211 

 
227 

 
243

 
4 

 
20 

$ 
36 

4 
52 

D 
68 

T 
84 

d 
100

t 
116

ä 
132

ö 
148

ñ 
164

┤ 
180

─ 
196 

 
212 

 
228 

 
244

 
5 

 
21 

% 
37 

5 
53 

E 
69 

U 
85 

e 
101

u 
117

à 
133

ò 
149

Ñ 
165

 
181

┼ 
197 

 
213 

 
229 

 
245

 
6 

 
22 

& 
38 

6 
54 

F 
70 

V 
86 

f 
102

v 
118

å 
134

û 
150

ª 
166

 
182

 
198 

 
214 

µ 
230 

 
246

 
7 

 
23 

' 
39 

7 
55 

G 
71 

W 
87 

g 
103

w 
119

ç 
135

ù 
151

° 
167

 
183

 
199 

 
215 

 
231 

 
247

 
8 

 
24 

( 
40 

8 
56 

H 
72 

X 
88 

h 
104

x 
120

ê 
136

ÿ 
152

¿ 
168

 
184

╚ 
200 

 
216 

 
232 

º 
248

 
9 

 
25 

) 
41 

9 
57 

I 
73 

Y 
89 

i 
105

y 
121

ë 
137

Ö 
153

 
169

╣ 
185

╔ 
201 

┘ 
217 

 
233 

• 
249

<LF> 
10 

 
26 

* 
42 

: 
58 

J 
74 

Z 
90 

j 
106

z 
122

è 
138

Ü 
154

 
170

║ 
186

╩ 
202 

┌ 
218 

 
234 

• 
250

 
11 

<ESC> 
 

27 
+ 
43 

; 
59 

K 
75 

[ 
91 

k 
107

{ 
123

ï 
139

¢ 
155

½ 
171

╗ 
187

╦ 
203 

█ 
219 

 
235 

 
251

<FF> 
12 

 
28 

, 
44 

< 
60 

L 
76 

\ 
92 

l 
108

| 
124

î 
140

£ 
156

 
172

╝ 
188

╠ 
204 

▄ 
220 

 
236 

 
252

<CR> 
13 

 
29 

- 
45 

= 
61 

M 
77 

] 
93 

m 
109

} 
125

ì 
141

¥ 
157

¡ 
173

 
189

═ 
205 

 
221 

 
237 

 
253

 
14 

 
30 

. 
46 

> 
62 

N 
78 

^ 
94 

n 
110

~ 
126

Ä 
142

 
158

« 
174

 
190

╬ 
206 

 
222 

 
238 

 
254

 
15 

 
31 

/ 
47 

? 
63 

O 
79 

_ 
95 

o 
111

 
127

Å 
143

ƒ 
159

» 
175

┐ 
191

 
207 

▀ 
223 

 
239 

 
255

 
The ID# for the PC 8 Character Set is (10U). 
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Serial Communication (RS - 232 C) connections for the Address Printer 
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Software Setup 

This section will help in setting up the Address Printer to run programs in Windows 3.1 and 
DOS. Some assistance is given for use on the Apple and Macintosh. If you are using Windows 
95 use the 13K driver installation disk that is included in the accessories kit. 

 Generic Software Driver Information 
 

Most software packages allow you to select or setup a printer driver. Use one of the 
following printer drivers. 

 
Dumb Printer 

Generic Printer 

Typewriter 

Plain Vanilla 

Teletype 

TTYCRLF Printer 

TTYCR Printer  (This requires the Setup Menu CR = CR + LF option to be 

turned on) 
 

If none of these choices are available one of the following may work: 
 

HP Laserjet Series II or any Laserjet II listed (excluding Postscript) 

HP Laserjet 4 

DOS Text Printer 
 

Don't forget to set the MODE COMMAND!!! 

Type the MODE command at the DOS prompt or add the MODE command to the 
AUTOEXEC.BAT file. The AUTOEXEC.BAT will load the command when the 
computer is first booted up. 

Example: 

When printing to the parallel port load MODE LPT1:,,P 

When printing to the serial port load MODE COM1:9600,N,8,1,P 

(NOTE:  The printer ports or parameter settings may vary from the preceding 
MODE command examples. If using DOS version 5.0, a ,,B may be substituted for 
the ,,P) 
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MICROSOFT WINDOWS™ Applications Software Driver Information 
 
 Microsoft Windows Software Driver Information 

 
When using Microsoft Windows 3.0 or later, select the Generic / Text printer driver. 

 

 Microsoft Windows95 Software Driver Information 
 

Changing the Print Driver Properties might have to be made for the printer to work 
with different software packages in the 
Windows95 operating environment. 
 

1. Click START ... SETTINGS... PRINTERS 

2. Highlight the printer driver being used (usually 9K-L 
or 9K-LC) 

3. Click FILE ... PROPERTIES 

4. Click on the DETAILS tab 

5. Click on PORT SETTING ... make sure that all of the 
boxes are checked ...OK 

6. Check the GRAPHICS tab when pictures are missing 
or printed out incorrectly. Note: Some software may 
require clicking on an OPTIONS button to open a 
dialog box of check boxes options. 

7. Click on APPLY once settings are correct. 
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Software Interface sample:    AccuZIP 6 for Windows 
 
Installation: 
 
Follow the instructions in the User Manual to install Accuzip 6. 
 
Choose Print Setup from the File Menu. 

 
 

The Print Setup 
window will be 
displayed. 
Select the 
Generic/Text 
Only printer. 

Click on OK 
 
Choose Print from 
the File Menu, then 
select Labels. 
 
 

 
The Print Labels 

window will be 
displayed. 

Select the desired 
option 
Click on Continue. 
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The Print window will be displayed. Select Label Format. 
Ensure that there is not a check in the Print Barcode box. 
Select the BRYCE.LBX label template. 
 
Select Continue. 

 
 

Another Print window will be displayed. 
Ensure that the Generic/Text Only is the selected printer. 
Choose the desired Print range. 
NOTE: 
1. Set the address setup option, in the Bryce setup menu, to 8 lines. 
1. Ignore the print quality selection that is displayed in the Print quality section of the Print 

window. The print quality you 
desire can be set in the Bryce 
Main Menu under the Print 
Quality option. 

Select OK to print to your Bryce 
Address printer. 
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Software Interface sample: Lotus Approach  ver. 3.0 for Windows 
 
Installation: 
Follow the instructions in the User Manual to install Lotus Approach 

Open Your Database 

Select Mailing Label from the Create Menu, The Mailing Label Assistant window will be 
displayed, 
Select Avery 5162, 5262: 1 1/3” x 4” as the Label Type (see below). 
Place the required fields, as shown below. Your address structure may differ, this is just an 
example. 

 
Click on Options and make changes as shown below. 

 
continued on next page 

Click on Printer Setup. 
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Select the Generic/Text Only printer driver. 
Click on OK. 
This will return you to the Mailing Label Assistant window. 
Click on OK. 
 
The label that you just created will be displayed. 
Select Design from the View Menu. 
Position your fields as shown below. 

 
 
Set the Address Setup, located in the Bryce setup Menu, to 8 lines. 
You are now ready to print labels on your Bryce printer. 
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Software interface sample: ARCLIST ver. 2.06 
 

The Arclist program must be configured for use by the Bryce BOS 13K in terms of both printer type selection and 
output type selection. 
 
You must first identify the Bryce BOS 13K printer. 
 Run Arclist program called CONFIG. 
 Choose PRINTER from menu, then choose CUSTOM from menu, then type Bryce BOS13K as  printer. 
When this information is entered, a PORT menu will be displayed. 
 Select appropriate port, and characteristics if using a serial port. 
NOTE: The BOS 13K must have the same port characteristics as the computer port. 
 All special entries (line feed, fonts, etc.) should be left blank. 
 Select SAVE from menu, then choose OKAY from menu. 
 Select QUIT from menu, then choose SAVE from menu. 
 
Next identify the address format. 
 Run ARCLIST. 
 Select LABELS from menu, then choose PRINT from menu, use the arrow keys to select a format. 
 Select Bryce BOS 13K. 
 Enter data according to the table below. 
 

Title: Bryce BOS 13K 
Label Type: envelope 
Pitch: pica 
Font: Normal 
Line Feed: Normal 
Left Margin: 0 
Label width in chars: 42 
Lines per label: 8 
Top Margin: 0 
Labels Down: N/A 
Lines Between Labels: N/A 
Labels Across: N/A 
Space Between Labels: N/A 
 
Criteria: All 
Index: Record 
Order: Ascending 
Printer: Bryce BOS 10K 

 
 Select ALL or Nth 
 Select INDEX or PRESORT 
 Select DEFAULT from Printer Menu 
 Select NON-STOP or PAUSE 
 Select GO from Printer menu 
Print Mailing Labels 
NOTE: To pause program while printing, press ESC on Computer Keyboard rather than taking the BOS 13K
 Off-Line . 
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 Software Interface sample: Bulk Mailer + 4.20i for Windows 
 
Installation: 
Follow the instructions in the User Manual to install Bulk Mailer. 

Select New from the File Menu. 
Follow the instructions in the Users Manual on how to enter your address information. 
When you are ready to print addresses; 

Select Direct Format from the Report Menu. 

Select Edit Report from the Format Menu. 
Move the fields to the upper left corner of the mail piece, as shown below. 
Select Preview Report from the Format Menu. 

 
Select Print Setup from the File Menu. 
Select the Generic / Text Only printer driver, as shown below. 
Click on OK. 

 
continued on next page
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Select Print Direct from the File Menu. 
Select the Bryce printer from the Print Direct Window (shown below). 
 

 
 

 
Set the ADDRESS SETUP, located in the Bryce printers Setup Menu, to 8 lines. 
 
You are now ready to print. 
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Software interface sample: DATAPERFECT ver 2.2 
 
Refer to the DataPerfect Reference Manual to setup a database for printing labels. 

While using DataPerfect, a label must be defined in order to print your addresses on the BOS 
13K. 

Be sure the cursor is in the panel from which you want to run the report. 

Press Report/Export (Shift-F7) to access the report list. 

With the cursor on Built-In Short Reports, press Insert to create a new report. 

Select Edit Report Name (9), then enter the desired report name (for example, BOS 13K Label).  
If you want to send report to the BOS 13K, select Printer On/Off (1), then type in the 
appropriate port number. 
 
 Select Print Margins (7), then enter the following data: 
 Top   0 
 Bottom  0 
 Left   0 
 Text Lines  7 
Select Edit Report Form (8). 
 
Move the cursor to the Report Body section of the report form, then press Report Options 
(Ctrl-F7). 
 
Select Labels (5). 
 
Enter 1 as the number of labels across the page. 
 
Enter 45 as the width in characters of each label. 
 
Enter 7 as the number of lines per label. 
 
The code for the label specifications is displayed in the Report Body section. 
 
Use Select (F4) to select the fields needed for the labels. Be sure that the alphanumeric fields are 
edited to include the ;;T print mode indicator. (See Field Format, Print Mode Indicators in your 
Reference Manual). 
 
Press Exit (F7) or Save (F10) to save the report form when you have completed selecting fields. 
You will return to the Report Menu. 
 
Set the ADDRESS SETUP in the BOS 13K SETUP MENU to 7 lines. 
You are now ready to print addresses on your BOS 13K. 
Press Report/Export (Shift-F7) to run the report. 
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Software Interface sample: dBASE IV ver 1.0 
 
Upon entering dBASE, the dBASE Control Panel will be displayed. 
To Create a Label, move cursor to the labels column and select <create>. 
A label will be displayed on the screen. 
Press ALT & D, to pull down the Dimensions menu, the following settings should be entered; 
Width of label   45 
Height of label   Set to the number of lines in your address 
Indentation    0 
Lines between labels   1 
Space between columns  1 
Columns of labels   1 
 
Press ESC 
Add fields to label using the instructions at the bottom of the screen. 
Once you have completed your layout, press ALT & L to pull down the Layout menu and 
select; 
 Save this label design. 
When this label format is saved, it will be displayed as a file under the labels column in the 
control panel. 
To Print labels; 
Activate a data file; 
Select the label file you created under the labels column; 
Follow menu directions to print. 
 
NOTE: dBase IV does a CR & LF before each address, therefore you must do the 
following:  
 IF SEVEN LINE ADDRESS, DO A FF BEFORE THE START OF THE NAME, 
 Example <CR> <LF> 
 CHR(12)+NAME 
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Software interface sample: FILE EXPRESS ver. 5.1 
 
When using FILE EXPRESS, A label must be defined in order to print your addresses on the 
BOS 13K. 

Select Label Printing (6) from the Main Menu. 
Select Design a New Label from Label Menu. 
Enter Data into the Label Spacing Screen according to the following table: 
1 How many labels across the page (1-5) 1 
2 Spaces across from label to label (10-500) n/a 
3 Lines down from label to label (1-999) 7 
4 Printable lines on each label (1-250) 7 
5 Characters per line on each label (10-999) 45 
6 Tab position to first label (1-99) 1 
 
When you have completed entering this data, press F10 to accept these changes. 
A Test Printer Screen will be displayed, if you would like to test this setup press Y, if not press 
N. 

File Express will display a label box on the screen the size that was specified on the Label 
Spacing Screen. 

Type ALT-F to pop up field window. 
Move highlight bar to the field you would like on the first line of your label. 
Press Enter twice, to accept it as a field only. 
Repeat the above sequence to place your fields in the appropriate locations. 
When you are finished designing your label, press F10. 

The Record Selection Screen will be displayed.  Press Enter. 

The Label Sub Menu will be displayed. 
Select S (to select save option). 
Press Enter (to confirm you want to save). 
Type in a name for your label. 
Press Enter. 
Type a description for you label. 
Press Enter (to save your label layout) 

While you are in the Label Sub Menu, now would be a good time to specify a printer. 
 Press 7 to update printer options. 
 Press Enter 
 Press ALT-S to select a printer definition file. 
 Select POSTSCRIPT - Generic., and press Enter. 

CONTINUED ON NEXT PAGE 
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FILE EXPRESS ver 5.1 continued 
 
The Printer Option Menu will be displayed, enter the following data: 
 
1 Printer Definition File PostScript 
2 Printer Port <1>, <2>, <3>, or <D>efault (LPT1) Enter the appropriate port # 
3 Line Spacing 6 
4 Pitch R for regular 
5 Printer Initialization String D for Default 
6 Printer Reset String D for Default 
 
Press F10 
Select Record# 
Select Yes 
 
Set the Address Setup Menu on the BOS 13K to 7 lines.
 
You are now ready to print addresses on your BOS 13K printer. 
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Software interface sample: IBM FILING ASSISTANT 
 
Refer to the IBM Filing Assistant manual to setup a database for printing labels. The program 
uses pre-set printer specifications which are defined. 
 
 From the main menu choose PRINT 
  
 From the print menu choose PREDEFINED PRINT SPEC. 
 
 Create a new print spec called BRYCE 
 
Set up the format for the output of the address as follows, or alter it to better suit your database. 
(A proper address format, as per USPS guidelines, is listed in Appendix H). The X and the + 
symbols are an important part of the print specifications. 
 
 
 Name: X 
 Title: X 
 Company: X 
 Address: X 
 City: + State: + Zip: + 
 
Using the Bryce print spec, the program should now be able to output your address list to the 
Bryce Machine. 
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Software Interface sample: Microsoft FoxPro 2.6 for Windows 

Installation: 
Follow the instructions in the User Manual to install Microsoft FoxPro. 

Choose Label from the Catalog Manager, then click on New. 

 
The Create Label window will be displayed. Select the table or query you wish to create a label 

for. 
Click on Label Wizard 

 
continued on next page 
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The Label Wizard - Step 2 of 5 window will be displayed. 
Select Avery #5165  (8½ x 11) 
Click on Next. 

 
The Label Wizard - Step 3 of 5 window will be displayed. Select the fields you wish to include 

in your label. 
Insert a space between the City and State fields, and also between the State and Zip fields, as 

shown below. 
When you have done this, Click on Next. 

 
continued on next page 
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The Label Wizard - Step 4 of 5 window will be displayed. Select the field or fields you wish to 
sort by. 

Note: If Descending is selected, the mail pieces will be stacked in ascending order when they 
exit the Bryce printer. 

Click on Next. 

 
The Label Wizard - Step 5 of 5 window will be displayed. 
Select Save Label for Later Use. 
Select Finish 
 
The Save As window will be displayed. 
Enter a filename for the label file. In our example, we have selected the filename 

BOS_TEST.lbx. 
Select OK. 
 
This will bring you back to the Catalog Manager. Select the file Bos_test. 
Click on Modify. (see next page) 
 
 
 
 
 
 
 
 
 

continued on next page 
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The Change Label window will be displayed. 
Click on Label Writer. 

 
 
 
 
 
 

continued on next page 
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The Microsoft FoxPro Label Edit window will be displayed. 
No fields will appear on the display, this is because the fields are located towards the bottom of 

the label. 
Click on the side scroll bar until you see the fields. 

 
Move the fields to the top left of the label, as shown below. 
Make sure that you move the first field to the 0,0 position. 

 
Select Save from the File Menu. 
Select Close from the File Menu. 
 
 

continued on next page 
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Select Print from the Catalog Manager. 
The Catalog Manager Print window will be displayed. 
Select Printer as the destination. 
Click on OK. 

 
The Print window will be displayed. 
Click on Setup. 

 
Select the Generic/Text Only printer driver. 
Click on OK 

 
Set the ADDRESS SETUP, located in the Bryce printers Setup Menu, to 66 lines. 
You are now ready to print. 
Click on OK. 
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Software interface sample: LOTUS 123 Release 3.1+ for DOS 
 
Before running 123, the Bryce printer must be installed by choosing "GENERIC" "no 
backspace" for printer specification. 
 
Run 123 
 
Address should be entered in a single column, all addresses in file must have the same number of 
lines (add blank lines if required). 
 
Set the ADDRESS SETUP in the BOS 13K menu to equal the number of lines each record. If 
page breaks are used, set ADDRESS SETUP in the BOS 13K menu to 1 line more than the 
number of lines in each record. 
 
Turn AUTO LINE FEED ON in the 13K Setup Menu. 
 
Select PRINT 
Select PRINTER 
Select OPTIONS 
Select OTHER 
Select UNFORMATTED 
Select ADVANCED 
Select AUTOLF 
Select YES 
Select QUIT 
Select QUIT 
Select GO 
 

 P/N 90-00093-001 



 Appendix F  Printing with Software 
 

Revision B 13K USERS MANUAL Section F - 23 

Software interface sample: MailMiser ver 1.2 

Refer to the MailMiser User's Guide to setup a database for printing labels. 
While using MailMiser, a label must be defined in order to print your addresses on the BOS 13K. 

Select System/Printer Functions (9) from the Main Menu. 
 The System/Printer Function Menu will be displayed. 
 Select Printer Selection (3). 
  The Print Selection Menu will be displayed. 
  Select BRYCE BOS 12K. 
You will be returned to the System/Printer Functions Menu. 
 Enter data according to the following table. 

1. Function "Typing" Keys  
2. Rebuild Indexes  
3. Printer Selection Bryce BOS 12K 
4. Reset Printer Yes 
5. Special Printer Codes  
6. Default Directory  
7. Color/Monochrome enter monitor type 
8. Delivery Point Barcode NO 
9. Printer passes for Barcode 1 
0. Exit to Main Menu  

 
Select Exit to Main Menu (0), after you have entered the above data. 
The MailMiser Main Menu will be displayed. 
 Select Label/Envelope Sizes (8). 
  Select Choose from standard label sizes (1). 
  Select Direct Image Printer, 1 up, 0 margin. 
 

MailMiser will ask you if you want to Print a Test Pattern, select NO at this time, this will return 
you back to the Main Menu. 
 Select Label/Envelope Sizes (8). 
  Select Edit current label size (2). 
  Enter data according to the following table. 
 
Label Description Direct Image Printer, 1 up, 0 margin 
Label Width 4.5 
Left Margin 0 
Inches from top of 1 label to top 
of next label 

1.167 (for a 7 line address) 
approx. .167 per line, at 6 lpi 

Number of Labels across 1 
Number of Spaces Between Labels 0 
Lines Per Inch 6 lpi (default) 
Characters Per Inch 10 cpi (default) 
 
Select Print Labels from the Main Menu to print addresses. 
NOTE: Select NO when the program asks you if you want to print Postnet Barcode. 
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Software interface sample: MULTIMATE 
 
An address may be printed using Multimate Merge Print. 
 
Refer to MULTIMATE and create a merge file. The following is an example of a typical merge 
document for addressing: 
 
name 
title 
company 
address 
city state zip 
 
From the main menu, select merge print, When the DOCUMENT PRINT OPTION screen is 
reached, set up the following section of parameters as shown below: 
 
Enhanced [N]/ Draft [Y] Y 
Print Action Table (PAT) TTYCRLF 
Pauses Between Pages [N or Y] N 
Print Comments [N or Y] N 
Print Document Summary [N or Y] N 
Print This Screen [N or Y] N 
Justification [N or Y or (M)icro] N 
Lines Per Inch [6 or 8] 6 
Paper Length (lines per page) 8 
 
The option listed on the document Print Option screen which are not listed above are either not 
applicable to printing addresses or are specific to your particular installation. 
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Software interface sample: MyMailList ver. 1.9.7 
 
Addresses may be printed on the BOS 13K using MyMailList. 
 
After entering your data: 
Press F3, the cursor will move into the Print Format window. 
 Select 3 1/2 x 15/16 labels 
   1 label across 
   0 left margin 
   1 copy 
 
 NOTE: MyMailList does not allow you to create a custom label size, therefore you 
have two  choices; 
  1. 3 1/2 x 15/16 labels - this limits you to 6 lines per address and   
  35 characters per line. 
  2. Envelope - this also limits you to 6 lines per address, and   
  pauses the printer after each address. 
 
Press F4, the cursor will move into the Print window. 
 Enter the Start and Stop Data as required. 
Set ADDRESS SETUP on the BOS 13K to 6 lines. 
Press F10 to Print. 
 
MyMailList is set to print to whatever printer you have connected to Parallel Port #1 (LPT1). If 
your BOS 13K is not connected to LPT1, press Ctrl-P to view the Printer Choice Menu., and 
select the correct port. 
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Software Interface sample: Postalsoft Desktop Mailer ver. 5.0 for Windows 
Installation: 
Follow the instructions in the User Manual to install Postalsoft Desktop Mailer. Install the Bryce 
10K  printer driver that is supplied with Postalsoft Desktop Mailer. 

Select New from the File Menu. 
Select the required fields. (See the new record layout example below.) 

 
When the data is inserted into your database, you must select a template. 
Select Choose Template from the Print Menu. 
Select New. 
In the example below, a template named bryce.tpl has been created. 

 

continued on next page
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When the template is created, you must choose a form. 
Select Choose Form from the Print Menu. 
Select New from the Choose Form for Printing Menu. 
Enter the parameters into the Edit Form window as shown below. 
 

 
 

 
The next step is to select a printer. 
Select Choose Printer from the Print Menu. 
Select Bryce 10K on LPT1 (LPT1 is used as an example, the actual printer port that you have 

the Bryce 10K assigned to in Windows will be displayed here.) 
Click on OK 

 
Set the ADDRESS SETUP, located in the Bryce printers Setup Menu, to 8 lines. 
 
You are now ready to print. 
Select Print Labels from the Print Menu. 
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Software Interface sample: PreSort Pro by MCS version 2.4 for Windows 
 
Installation: 
Follow the instructions in the User Manual to install PreSort Pro. Install the Standard/Text only 
printer driver that is supplied with PreSort Pro. 

Select New from the File Menu. 

Select the required fields. (See the new record layout example below.) 

 
 
When the data is inserted into your database, you must select a template. 
Select Choose Template from the Print Menu. 
In the example below, a template named bos_test.tpl has been created. Notice that there are no 

printer control codes displayed at the beginning or end of the template. 

 

continued on next page
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When the template is created, you must choose a form. 
Select Choose Form from the Print Menu. 
Select bryce.frm from the Choose Form for Printing Menu (shown below). 
 

 
 

 
The next step is to select a printer. 
Select Choose Printer from the Print Menu. 
Select Standard/Text Only, (as shown below). 
Click on OK 

 
 

Set the ADDRESS SETUP, located in the Bryce printers Setup Menu, to 8 lines. 
 
You are now ready to print. 
Select Print Labels from the Print Menu. 

 P/N 90-00093-001 



 Appendix F  Printing with Software 
 

Revision B 13K USERS MANUAL Section F - 30 

Software interface sample: RAPIDFILE 
 
Before running RAPID FILE, a printer driver must be loaded. This is done by running RAPID 
FILE's Printer program from DOS as explained in the RAPID FILE manual. 
 
The printer file to select is called GENERIC, and must be set up as one of the printer devices 
with appropriate I/O port settings. 
 
From within RAPID FILE when printing addresses: 
 
1. Select FILE from the main menu 
2. Select RETRIEVE FILE or CREATE ( If you choose to create, enter data) 
3. Select LAYOUT 
4. Select LAYOUT TYPE 
5. Select LABEL 
6. When asked if you want to design a label - Select YES 
 
 A LABEL WILL BE DISPLAYED IN THE CENTER OF THE SCREEN 
 
7. Press F10 
 Select SHOW FIELD, Fields will be displayed on the right side of the screen. 
 Select FIELD 
  Use arrows to set field width. 
  Use arrows to drag field into position. 
 REPEAT Step 7 until all fields are placed 
8. Press F9 to Implement 
9. Select PRINT from main menu 
10. Select DESTINATION 
11. Select BEGIN PRINTING 
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Software interface sample: REFLEX ver. 2.0 
 
Referring to the REFLEX manual, run REFLEX, load a file, or create a file. 
 
Create the fields required. 
 
Select Reports & Labels from the Views Menu. 
 This will bring you to the Report Design display. 
 
Select Make Labels from the Report Menu. 
 
Select Customize Labels from the Report Menu. 
 
Set: Label Width:   45 
 Label Height:   7 
 Lines between labels:  0 
 Spaces between labels: 0 
 Labels across page:  1 
 Compress blank lines:  Yes or No 
 Left margin:   0 
 Setup String:   (blank) 
Select Proceed. 
 
Place cursor at the beginning of the first line of the label. 
 
Enter field names into label. 
 
Select Local Properties from the Report Menu when you are done entering the field names into 
the label. 
 
Set the field widths as required, set State field width to two (2) characters. 
 
Click on State and Zip fields, and move to create a space between the City and State field, and 
the State and Zip field. 
 
You are now ready to print addresses on your BOS 13K. 
 
Select Print from the Utilities Menu. 
 
Set Address Setup on the BOS 13K to seven (7) lines. 
 
Select Print to Printer. 
 
Select Proceed. 
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Software interface sample: WORDPERFECT 6.0 
 
Addresses may be printed with WORDPERFECT 6.0 using merge printing. This requires the 
creation  of a primary and a secondary file. Refer to your WORDPERFECT manual for 
instructions. 
 
The following is an example of a typical merge primary file for addressing: 
 
{FIELD}1" 
{FIELD}2" 
{FIELD}3" 
{FIELD}4" 
{FIELD}5" 
 
The following is an example of a typical secondary file for addressing: 
 
John Doe{END FIELD} 
123 Main Street{END FIELD} 
Anytown, CT. 12345-6789{END RECORD} 
 
Before performing the actual merging of data from your secondary file, several options must be 
chosen: 
 
 Set Margins Top  0" 
   Bottom 0" 
   Left  0" 
   Right  0" 
 
You may now merge the two files. 
 
From the Tools menu, select Merge 
 Select Run 
 Enter Form filename (Primary File) 
 Enter Data filename (Secondary File) 
 Select Merge 
 
From the File menu, select Print/Fax 
 Select DOS Text Printer  
 Select Edit, and insure correct port is selected for the DOS Text Printer 
 
You may now print address lists on your BOS 13K Print Station. 
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Software interface sample: WORDSTAR FOR DOS  ver. 7.0 
 
From the File Menu select New. 
 
From the Layout Menu select Page. 
 
Enter the following settings: 
 
 Odd Offset  0.00 
 Even Offset  0.00 
 Top   0.00 
 Bottom  0.00 
 Header   0.00 
 Footer   0.00 
 Orientation  Portrait 
 Page Length  1.34 
 Paper Bin  Leave Blank 
 
Select OK. 
 
The screen should now display the following information: 
.poo .00" 
.poe .00" 
.mt .00" 
.mb .00" 
.hm .00" 
.fm .00" 
.pl .00" 
.pl 1.17" 
 
Enter in the data for each record.  When a record is complete, press ENTER until a page break is 
displayed on the screen (a solid horizontal white line). 
Once the page break is displayed, you can enter the next record. 
Repeat this process to enter all records. 
 
To Print: 
 
Set the BOS 13K Address Setup to eight (8) lines of address. 
Select Change Printer from the File Menu. 
Select Draft Printer. 
Select OK. 
Select Print from the File Menu. 
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POWER PRINT for the MACINTOSH 
 
PowerPrint by GDT Softworks consists of software printer drivers and a high speed serial-to-
parallel adapter which allows for a virtually transparent connection between your Macintosh and 
the BOS 13K. 
 
Installation: 
 
Follow the instructions in the User Manual to install PowerPrint.  Select the LaserJet 4 printer 
driver to install for use with the BOS13K. 
 
Activating Your Driver: 
 
• Go to the Apple menu and select Chooser. 
 
• Select the LaserJet 4 printer driver. 
 
• Click on the serial port to which you have the BOS 13K connected, either the modem 

(phone) or printer icon. 
 
NOTE:   If you are connecting your printer cable to the printer port, Appletalk must be set to 

"inactive". 
 
• Click on the box labeled Cartridges.  A Cartridge Mapping window will be displayed.  Map 

the following fonts: 
Mac Font called Courier to print as the HP Font Courier. 
Mac Font called Helvetica to print as the HP Font Arial. 
Mac Font called Times to print as the HP Font Times New. 

• Click on OK. 
• Close the Chooser by clicking on the close box in the upper left corner.  The Address Printer 

is now configured to print with the PowerPrint driver. 
 
Printing: 
 
Go to the Setup Menu on the BOS13K and turn on Auto Line Feed. 
 
While in an application, go to the File menu and select Page Setup.  Select: 
• Paper = US Letter 
• Reduce or Enlarge = 100% 
• Page Orientation = Portrait 
• Printer Effects = Fractional Widths 
Click on OK 
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POWER PRINT for the MACINTOSH  (Continued)  
 
Page Setup: 
 
• Select Show from the Layout menu, then select Non-Printable Area. 
• Set page width to 8.5 Inches (215.9 mm). 
• Set page length to 11 inches (279.4 mm). 
Measure the position of your address from the bottom edge of the paper, just as you would from 
the bottom edge of your mail piece.  See example shown below. 
 

8.5 x 11 Inches 

 
Non-Printable 
area 

Printable 
area 

Bryce Office Systems 
115 Hurley Road 
Oxford, CT 06478-1035 

2.0 Inches 

4.0 Inches 

 
Go to File menu and select Print.  Select: 
• Print Mode = Draft 
• Feed = Automatic 
Click on Print. 
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Computer setup sample: IBM Mini's (System 34, 36, 38) & AS400 
 
To use the BOS 13K with any IBM minicomputer or mainframe, it is necessary to interface 
through some kind of protocol converter. This may be one of two types of systems; either an 
IBM compatible micro with an emulation card, or a stand alone protocol converter such as is 
available from Black Box Corp. in Pittsburgh, PA (i.e., model PQ-6 RO). In either case the 
installation is very similar. 
 
1. The protocol conversion device must be connected to the IBM computer with the 
appropriate  cable. 
 
2. After deciding on a free work station address to be used for the BOS 13K, the system 
 configuration must be altered to setup the work station address and port as an IBM 5256 
 printer. 
 
3. The emulation system must be setup at the same workstation address and must be setup 
for  IBM Proprinter II emulation. 
  
 For a system 36 installation, with IBM advanced emulation, the following is the correct 
 procedure to follow on the PC: 
 
 A. Boot the PC with DOS 
 B. Running off the advanced emulation program disk, type "Config DP5250.dat" 
 C. Select 2 Emulation sessions 
 D. Select the appropriate keyboard 
 E Set workstation addresses for the two sessions, as configured on the system 36 
 F. Set 5256 Printer Emulation 
 G. Select IBM Proprinter II 
 H. Save profile data and exit 
 
4. A procedure must be written and run which sets the printer port for the page length of 6 
 lines (BOS 13K with LCD SETUP MENU to set up the ADDRESS SETUP to  6). 
 
5. An RPG program will probably be necessary on the system 36 to produce a data format 
which  is "one-up" label compatible. 
 
6. You may now print address lists on your BOS 13K. 
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Software interface sample: MICROSOFT WORD FOR WINDOWS ver. 2.0 
 
Using you mouse Select FILE 

Inside the pull down menu for File, Select NEW 
 Once New has been selected a pop up window will appear. 
Scroll through the available documents using the down arrow, Select MAILLABL 
Now Select OK 
Now a new pop up window appears called Mailing Labels 
Inside the  Mailing Labels section, Select DOT MATRIX 
Now another new pop up window appears called Dot Matrix Printer Label Sizes. 
Scroll through the selection of product numbers for Avery Dot Matrix Labels, 
Select 4600 ADDRESS 
Then Select OK 
Now another new pop up window appears called MicroSoft Word. 
Select SINGLE LABEL 
Now a new pop up window appears called Mailing Labels which depicts a sample 
label for six (6) lines. 
Type data into each line of the label address, TAB to go to NEXT LINE 
When address data is completely entered, Select DONE 
To print the sample label, select FILE 
Inside the pull down menu for File, Select PRINT SETUP 
Now a new pop up window appears called Print Setup 
Select GENERIC/TEXT ONLY ON LPT1 
Select OK 
Select FILE 
Inside the pull down menu for File, Select PRINT 
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Software interface sample: Word97 for Windows 95 
 
Select Page Setup from the FILE menu. 
Select the Margins tab, and set ALL margins to zero (0) 
 

 
 
Select the Paper size tab, then select Custom from the Paper size text box. 
 
Set the page width to 4.2” 
Set the page height to 1.4” 
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Select OK. After you select OK, you may see a warning similar to the warning shown  
below. Click on the Ignore button. 
 
Select Page Layout from the 
VIEW menu, and your page 
should look similar to the example 
show below. 
 
To print to the 13K printer: 

Note: Make sure that  
the ADDRESS SETUP 
option in the Bryce 
Setup Menu is set to 
Nine (9) lines or 
greater. 

Select Options from the TOOLS 
menu. 
 
Select the Compatibility Tab 
from the OPTION dialog box. 
Select Custom from the 
RECOMMENDED OPTIONS 
FOR: pull down menu. Check 
the box next to the Use Printer 
Metrics to layout document. 
Verify that none of the other 
boxes have a check inside. The 
dialog box should look like the 
options box below. 
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To make a Mail Merge select Mail Merge from the TOOLS menu. 
The Mail Merge Helper window similar to the one 
to the right will appear.  Select the Create pull 
down menu. 
Select “Form Letter”. Select the “Active 
Window” as the document that you wish to use. 
Select “Get Data” from the Mail Merge Helper. 
Select the file you wish to merge with your MS 
Word document. You will get a message similar to 
the one below stating “Word found no merge 
fields in your main document”. Click on the 
“Edit Main Document” button. 
Move the cursor to the position you would like 
your address to begin. 
Select “Insert Merge Field” from the toolbar. 
Insert the fields you want on the form. 
Select the Merge to Printer icon from the toolbar. 
Your page should look similar tot he last example 
below. 
 
The Print dialog box will appear. 
Make sure that the Generic/Text only printer is 
selected. 
Click OK to print. 
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AGENCY REGULATORY NOTICES 
Notice: Changes or modifications to this unit not expressly approved by the party responsible for compliance 
could void the user’s authority to operate the equipment. 

Federal Communications Commission Compliance 
"This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 

1). This device may not cause harmful interference, and 
2). This device must accept any interference received, including interference that may cause 

undesired operation. 

NOTE:  This equipment has been tested and found to comply with FCC Rules Part 15 subpart B Class B 
for a digital device. These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference to radio communications. 
If this equipment does cause harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the 
following measures: Reorient or relocate the receiving antenna. 

- Increase the separation between the equipment and receiver. 
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
- Consult the dealer or an experienced radio / TV technician for help. 

Shielded cables must be used with this unit to ensure compliance with the Class B FCC limits. 
This device complies with the requirements of the following standards: 

Complies to “CE” Mark requirements of: 
• EMC Directive 89/336/EEC and as AMENDED 
• Low Voltage Directives 73/23/EEC and as Ammended 

 EN 55022, CLASS B, 
“Conducted and Radiated Emissions” 

 EN 50081-1: 1992 
“Radiated Emissions” 

 EN 50082-1:1992, 
“General Immunity Standard: Residential, Commercial, and Light Industry” 

 IEC 801- 2: 1984 
“Electrostatic Discharge” 

 IEC 801- 4: 1988 
“Electrical Fast Transients, I/O and Power” 

 EN 50140 (IEC 801-3:1984), 
“Radiated Susceptibility”
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 Appendix G  Technical Specifications 

Canadian DOC Compliance. 
"This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations. 

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du 
Canada. 

 UL Standard 1950, 3rd Edition, 
 “Information Technology Equipment Including Electrical Business Equipment” 

 CSA Standard C22.2 No. 950-95, 
“Safety of Information Technology Equipment Including Electrical Business Equipment” 

 EN 60950: 1992 including Amendments 
EN6095 +A1:1992; +A2:1993; +A3:1995; +A4:1996 
 “Safety of Information Technology Equipment Including Electrical Business Equipment” 

 DIN:EN 60950 VDE 0805-1997, For GS Mark, and as AMENDED 
 “Safety of Information Technology Equipment Including Electrical Business Equipment” 
Der Drucker ist ein Geraet der Schutzklasse 1. 

Dimensions and Weight 
Height: 13 inches 33.1 cm 
Width.: 19 inches 48.3 cm 
Depth: 17 inches 43.2 cm 
Weight: 50lbs. (22.7 kg) including the high capacity print cartridge & Paper Catch 

Assembly. 

Electrical 
Voltage: Selectable voltages: 100v, 120v , 220v, and 240v 
Fuse Type (100 – 120 volts AC + or - 10%):  One 3AG. 2 Amp Slo-Blo fuse, at 250 volts, 

is required/provided. 
Frequency: 60 Hertz. + or - 3 Hz. Automatic frequency selection for other voltages. 
Power Consumption: 126 Watts 430 Btu/hr.  
Fuse Type (220 – 240 volts AC + or - 10%):  Two 5 x 20mm. 1.5 Amp Slo-Blo fuses, at 

250 volts, one for each leg, is required/provided. 
 
Elecktrische Daten (input) 

Eingangsspannung (Voltage):  220-240 VAC 
Eingangsstrom (Current): 0.5A 
Nennfrequenz (Frequency): 50HZ 
A Sicherungs Nenndaten (Fuse rating: ) 1.5 A 250VAC. 
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Warnung: Fuer kontinuierlichen Feuerschutz, sollten diw Sicherungen nur mit einer gleichen 
Typs und der gleichen Einstufung ersetzt werden. 

Achtung: Zweipolige bzw.Neutralleiter Sicherung. 

Media Size 
Media Thickness Minimum Maximum 
 0.003 inches(0.0762 mm) 1/4”   (6.350 mm) 
Paper Extents Width Length 
Minimum 3”  (76 mm) 5”  (127 mm) 
Maximum 12.5”   (330 mm) 15”   (390 mm) 

Environmental Conditions. 
Operating.  (Power On.), Temperature. 55.F - 95.F  (12.C - 35.C), 
 Humidity.      8% - 80% 
 Die maximale Umgebungstemperatur betraegt 35C. 
Non Operating.  (Power Off.),  Temperature. 42.F - 100.F  (5.C - 40.C), 
 Humidity.     10% - 90% 
Noise Level.  Sound Level: Less than 65 dBA (re 20µPa), A-weighted 

sound pressure level at the operator position. Measured in 
accordance with applicable ANSI and ISO standards. 

Maximum Printing Area 
Vertically  Horizontally 
15 inches (38.1 cm) 9.4 inches (23.8 cm) 

Print Density and Resolution.    
Draft:- 300 x 300 Dots per inch. - Light.  
Letter:- 300 x 600 Dots per inch. - Medium.  
Executive:- 600 x 600 Dots per inch. - Dark.  

Maximum Point Size 
Smallest  Largest 
4 point 30 point 

Printer Speed 
Bryce 13K  
Based on 18 characters per line, 12 point, 3 lines per address and no barcode. 
Media Draft Letter Executive Margin 
# 10 11,000 11,000 10,000 5 inch (12.7 cm) 
3x5 13,000 13,000 11,000 4 inch (10.16 cm) 
Based on 18 characters per line, 12 point, 5 lines per address and no barcode. 
Media Draft Letter Executive Margin 
# 10 7,400 7,400 5,800 5 inch (12.7 cm) 
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The Interface Panel 
The interface panel is located on the back of the machine. It contains the main power switch, the power 
receptacle and fuse.  The interface ports (parallel and serial) are the interface connections between the 
13K and your computer. 

1. Connect the line cord from the printer receptacle to a properly grounded outlet box.  Do not use 
an adapter plug.  Avoid using outlets that are controlled by wall switches and shared with other 
equipment. 

2. Connect the interface cable from the computer to the appropriate connector on the printer 
interface panel.  The typical cable length is six (6) feet long  (182. 9 cm) for parallel and fifteen 
(15) feet (457.2 cm) long for serial. 

Power Supply Cords (Line Cords) 
Appliance inlet is the main disconnect device. 

Der Geraetestecker dient zur Trennung der Netzspannung. 

“Bei Gefahr Netzstecker ziehen.” 

In the United Kingdom: 

 WARNING :-  THIS EQUIPMENT MUST BE EARTHED.  (GROUNDED.) 

 The cores in the main leads are colored in accordance with the following code: 
 - green and yellow  earth 
 - blue:    neutral 
 - brown   live 

- the lead which is colored green and yellow must be connected to the terminal in the plug which is 
marked with the letter E or by the earth symbol, or colored green and yellow. 

- the lead which is colored blue must be connected to the terminal which is marked with the letter N or 
colored black. 

- the lead which is colored brown must be connected to the terminal which is marked with the letter L or 
colored red. 

In Denmark 
Appliances which are delivered without a plug must be provided with a visible tag with the following text: 

   Vigtigt! 
 Ledern med gron/gul isolation ma kun tilslutters en klemme maerket eller 
 For tilslutning af de ovrige ledere, se medfolgende installationsvejledning. 

In the U.S.A.  
 A molded three pin plug and socket cable is provided with the printer. 
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DELIVERY POINT BAR CODE  
NAIC Certification 

This Address Printer is equipped with firmware for printing the United States Postal Service 
(USPS) Delivery Point Bar Code (DPBC). The printer is Certified by the National Address 
Information Center (NAIC). Certification from the NAIC indicates the printed POSTNET Bar - 
Code meets the required standards for letter size mail to receive USPS Delivery Point Bar Coded 
rates.  

Delivery Point Bar Code 

The Address Printer uses the data sent down on the last line to print the DPBC. Specifications for 
a valid addresses can be found in the Domestic Mail Manual (DMM). 

Alternate Address Formats 

The option to send the Address Printer a ZIP + 4 + 2 or ZIP + 4 + 3 address to print a Delivery 
Point Bar Code is available. Only the addresses with ZIP + 4 or ZIP + 4 + 3 digits are allowed by 
the USPS to appear in the address block.  
 

Valid Address Formats 
Address ZIP Codes Data Sent to  

Printer 
Printed in  

Address Block 
Bar - Code 

Printed 
ZIP + 4 + 2* 98765-1234~12 98765-1234 DPBC 
ZIP + 4 + 3* 98765-1234~123 98765-1234 DPBC 
ZIP + 4 + 3 98765-1234123 98765-1234123 DPBC 
 Illegal Format   
ZIP + 4 + 2 98765-123412 98765-123412 No Bar - Code 

* Add the Tilde (~) after the ZIP + 4 digits so the 2- or 3 - digit add on will not be printed in 
the address block. 

ZIP + 4 + 2 
The Address Printer will determine the correction digit and print the DPBC according to the ZIP 
code received. Using the ZIP + 4 + 2 format requires that the Tilde (~) character be sent between 
the ZIP + 4 and 2- digit characters. Only  ZIP + 4 digits will be printed in the address block. 

ZIP + 4 + 3 
The Address Printer will print the DPBC according to the ZIP code received. Two formats of 
printing the Zip Code in the address block are available. First option is to print all the digits of 
the ZIP + 4 + 3 in the address block. Second option is to only print the ZIP + 4 digits in the 
address block, by placing the Tilde (~) character between the ZIP + 4 and 3- digit characters. 
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Glossary 

baud rate 
The rate at which data is transferred between the computer and the printer. The computer and 
printer must be set at the same baud rate for information to transfer correctly. 

cable  
Wires that carry the information between the computer and the printer. 

Centronic parallel interface  
A device for connecting printers and other peripheral devices to a computer. It transmits a 
full byte at a time. 

Character 
A printable letter or symbol. 

character height 
The height of a uppercase letter. A character height is measured in points. 

characters per inch  
The number of character printed in a horizontal inch. Also called pitch. 

character set 
The set of characters or symbols that make up a language. 

clean print cartridge 
Describes the process of removing dried ink from the nozzles of the ink jet cartridge. 

configuration 
The settings used by the printer to communicate with the computer. Also the internal settings 
in the printer that control the print job. 

control code 
The instructions sent to the printer to describe how to perform the print job. 

control panel 
The buttons and display that are used to manually change the printers settings. 

cpi 
See characters per inch. 
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data communications  
The sending of data from the computer to a peripheral device i.e. the printer.  

dots per inch 
The number of ink dots printed in one horizontal inch. The larger the number the better the 
resolution of print. 

double feeding 
Two or more pieces of media feed at the same time or without separation. 

Dpi 
See dots per inch. 

draft quality 
Print resolution using 150 dpi which saves ink and allows faster printing of a document.  

Drivers 
A file used by the computers software to communicate commands and information that the 
printer needs to layout and print a document. 

embedded printer commands  
Commands sent in a record or document to instruct the printer to change printing options. 

EPROM 
Electronic Programmable Read Only Memory 

escape character 
A special non-printable character (ESC / ) used to instruct the printer to change printing 
options. 

escape sequence 
Commands sent beginning with the escape character that instruct the printer to change 
printing options: fonts, page orientation, etc. 

feed gap 
Opening between the ends of the H-Block Assemblies and the Feed Rollers so the media is 
fed one at a time. 

font 
A set of printable characters with consistent style and characteristics. 

Grounded 
A electrical circuit that has a voltage of zero. 
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Handshaking 
A method for the computer to communicate with peripheral devices to ensure complete 
transfer of information. 

hex dump 
A printer option that allows all the information and commands sent to the printer are printed 
as base 16 digits. 

Internal test address message 
The preprogrammed Address that is printed when the Test Env. button is pressed. 

interface cable 
The cable that connects the printer or other device to the computer. 

interface connector 
The connectors on both ends of the interface cable that insert into the interface ports. 

internal fonts 
Resident or built-in fonts that reside inside the printer. 

Jam 
See Paper Jam. 

letter quality 
Print resolution using 200 dpi which saves ink and provides a high quality document. 

lines per inch 
The number of lines printed in one vertical inch. 

Menu directories 
The list of available printer controls that appear on the bottom of the LCD display. A 
directory can contain other directories called sub-directories.  

Offline 
The printer will no longer respond to information sent from the computer. 

Online 
The printer will accept and respond to information sent from the computer. 

outline fonts 
Scaleable printer fonts. 

paper jam 
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When media gets stuck in the printer. 

Parity 
An error checking method used when communicating between the computer and a peripheral 
device. 

PCL commands 
A standard printer language developed of commands to access printer features or options. 

point size 
A measurement standard for Character Height. One point represents one seventy-seconds of 
an inch. 

Port 
See Printer Interface Port. 

Postal regulations 
Rules and guidelines setup by the United States Postal Service (USPS) for mail.  

power socket 
The socket on the back of the printer where the line cord is connected. 

print cartridge 
The cartridge that contains the ink for printing. 

print quality 
The quality of print, such as the resolution, sharpness of the image or font. 

printer driver 
See Drivers. 

Record 
A collection of related fields that make up the name and address of an individual in a 
mailing-list file. 

RS-232 serial interface 
A standard serial interface for connecting the computer to peripheral devices. 

sans serif 
A font typeface that contains no serifs or finishing strokes on the top or bottom of the 
characters. 

scaleable fonts 
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Outline printer fonts of characters and symbols that are stored in a mathematical form and are 
able to be enlarged or reduced. 

Spacing 
The relative spacing between characters. 

Stuffed media 

Media that is already filled and sealed for delivery. 

sub - directories 
A directory within a directory. 

Troubleshooting 

The process of finding the cause of a problem so that a solution can be found. 
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 Appendix J  Supplies & Fonts 

 

 

External Fonts & Supplies  
 
The following list of supplies and font cards are available through your local Bryce Office Systems dealer. 
 
 Description Part Number
 
 Bin Extension 03-00257-501 
 
Font Card: 
 Alpine 56-96000-001 
 Aurora 56-96001-001 
 Calico 56-96003-001 
 Centurion 56-96022-001 
 Dingbat #2 56-96005-001 
 Eureka 56-96006-001 
 Indio 56-96008-001 
 Memo 56-96010-001 
 Mettler 56-96011-001 
 Oakland 56-96012-001 
 OCR A 56-96013-001 
 Palomar 56-96014-001 
 Parker 56-96021-001 
 Santee 56-96016-001 
 Stockton 56-96019-001 
 3 of 9 Barcode 56-96020-001 
 Novarese 56-96031-001 
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